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Chapter 1 
Installation & Setup 

Installation & Setup 
WinPrompt® provides simplicity and efficiency combined with accuracy and consistency 
in pressure generation and measurement using a deadweight gauge. It automatically 
converts pressure to mass and mass to pressure while correcting for piston temperature, 
head height, absolute and gauge references, local gravity, and air density. WinPrompt® 
can be operated from a single window for industrial use or from additional detailed 
windows available for the metrologist. 

Features 

• Stores calibration coefficients for working standards including piston/cylinder 
effective area, thermal coefficient of expansion, pressure deformation coefficients, 
and all calibrated mass values and associated density. It also stores all of the critical 
system and environmental parameters including local gravity, head corrections, and 
air density. 

• Performs all necessary calculations of pressure-to-mass and mass-to-pressure in both 
S.I. and English units. 

• Computes the buoyant effect of the ambient air on the piston gauge masses and 
compensates accordingly. 

• Creates calibration procedures for performing repetitive type calibrations. Procedures 
include sequence of pressure values, pressure reference, corrections, and window 
sizes and locations. 

• Captures and saves information for direct import into Microsoft Word, Microsoft 
Excel, and other DDE-enabled applications for custom reports. Saves all information 
captured during the calibration for review and re-printing of calibration reports. 

• Additionally, WinPrompt® supports several interfaces to Ruska deadweight gauges 
that can provide: 

• Direct acquisition of float position, sink rate, piston temperature, vacuum, 
ambient temperature, barometric pressure, and humidity with continuous 
correction of calculated pressure. 

• Real-time graphing of acquired values. 

• Auto-float control of deadweight gauge. 
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Installing WinPrompt® Calibration Software 
1. Insert the WinPrompt® CD ROM into the disk drive. If installation does not start 

automatically, click Start→Run and type D:\setup, where D is replaced by the 
drive letter of your CD ROM.  

2. Follow instructions on the screen for installing the software. 

3. After installation WinPrompt® can be started by clicking 
Start→Programs→Fluke→WinPrompt® 

Running WinPrompt® for the First Time 
WinPrompt® will display the Welcome screen the first time it is run. 

 
gma01.bmp 

Figure 1-1. Welcome Screen 

Click OK and the WinPrompt® Start menu will appear. 

 
gma02.bmp 

Figure 1-2. WinPrompt® Start Screen 

If a WinPrompt® supported hardware interface will be used, connect it to the computer 
and turn it on before starting the Setup Wizard (see Appendix D for installing USB 
drivers). Then click Setup Wizard. It can also be run from the menu by clicking 
Help→Wizard at any time. Follow the onscreen instructions to find hardware interfaces 
and configure WinPrompt® to use them.  

After configuring attached interfaces, the Setup Wizard will check for installed pistons 
and display the number of pistons found. WinPrompt® will not function without at least 
one piston installed. The Setup Wizard will prompt for the location of the piston files or 
for the piston information based on the button clicked. Click Do Not Change to skip if 
pistons are already installed or to enter the information later. 
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Figure 1-3. WinPrompt® Setup Wizard Screen - Piston 

WinPrompt® will also check for installed mass sets. The Setup Wizard will display the 
number of mass sets found. WinPrompt® will not function without at least one mass set 
installed. The Setup Wizard will prompt for the location of the mass set files or for the 
mass set information based on the button clicked. Click Do Not Change to skip if mass 
sets are already installed or to enter the information later. 

 
gma04.bmp 

Figure 1-4. WinPrompt® Setup Wizard Screen - Mass Set 

WinPrompt® needs to know the local gravity. WinPrompt® includes an approximation for 
gravity based on latitude and elevation but use of this formula is not recommended. 
Change the units using the arrow button before entering the value. Click Ok when 
complete. 

 
gma05.bmp 

Figure 1-5. WinPrompt® Setup Wizard Screen - Gravity 

After the gravity is entered the Setup Wizard is complete. Click Start Calibration to 
close the Setup Wizard and open the Single Point Window to start a calibration. Click 
Close to just close the Setup Wizard.  
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Figure 1-6. WinPrompt® Setup Wizard Screen - Complete 
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Chapter 2 
Getting Started 

Overview 
WinPrompt® has a Single Point Window with all the features many users will need. 
Advanced users may have to open additional windows to add to the Single Point Window 
functionality. Cross floating cannot be done with the Single Point Window and requires 
the use of the advanced windows. 

New users to WinPrompt® are recommended to start with the Single Point Window 
unless cross floating is required. If a piston and a mass set file were not provided with the 
deadweight gauge, they must be created before using the Single Point Window. Refer to 
Enter Piston/Cylinder Information and Enter Mass Set Information under Advanced 
WinPrompt® Use then follow the Single Point Window instructions. 

How to Contact Fluke 
To order accessories, receive operating assistance, or get the location of the nearest Fluke 
distributor or Service Center, call: 

• Technical Support USA: 1-800-99-FLUKE (1-800-993-5853) 
• Calibration/Repair USA: 1-888-99-FLUKE (1-888-993-5853) 
• Canada: 1-800-36-FLUKE (1-800-363-5853) 
• Europe: +31-402-675-200 
• China: +86-400-810-3435 
• Japan: +81-3-3434-0181 
• Singapore: +65-738-5655 
• Anywhere in the world: +1-425-446-5500 

Or, visit Fluke's website at www.fluke.com. 

To register your product, visit http://register.fluke.com. 

To view, print, or download the latest manual supplement, visit 
http://us.fluke.com/usen/support/manuals. 
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Select WinPrompt®
 Display Units 

1. From the menu select Setup→Units. 

2. Select Set SI Units to configure WinPrompt® to display units in the International 
System of Units, or Set Default Units to configure WinPrompt® to display other 
default units. In either setting, individual WinPrompt® units can be changed to other 
options shown for each parameter. These changes will remain effective until changed 
by the user or by loading a *.PRC or *.CLB file. 

3. Click Ok. 

Single Point Window 
To perform a calibration using the Single Point Data window follow these steps:  

1. If the Single Point Window is not already visible, from the menu select 
View→Single Point Window. 

 
gma07.bmp 

Figure 2-1. Single Point Data Window 

2. Click Clear All Points  to clear the previous calibration. These points will be 
deleted. Save the file before clearing, if the points are needed. 

3. Select your Piston and Mass Set. Click the arrow next to the box to show a list of 
available pistons and mass sets. The Piston and Mass Set boxes are loaded with 
the available *.PC and *.MS files located in the WinPrompt® directory. The pistons 
and mass sets used will be listed on the Calibration report. 

If the dropdown boxes are empty, then no piston and mass sets have been found in 
the WinPrompt® directory. 

4. Select optional Head corrections. 

Oil Head  Check this box to enable oil head correction and show entry 
boxes. 

0.000 in  Enter the distance between the reference plane of the standard and 
the reference plane of the Device Under Test. 

Spinestic 22  Select the oil used in the system. 

0.00 in/in3  If <Other> is selected, enter the density of the oil used. 
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Gas Head  Check this box to enable gas head correction and show entry 
boxes. 

0.000 in  Enter the distance between the reference plane of the standard and 
the reference plane of the Device Under Test. 

Nitrogen  Select the gas used in the system. If a listed gas is used, the 
density will be corrected for pressure. 

0.00 in/in3  If <Other> is selected, enter the density of the gas used. The 
density will not be corrected for pressure 

   The Device Under Test is higher than the standard. 

  The Device Under Test is lower than the standard. 

5. Enter or verify process variables. If the background is yellow, the value is out of 
range. Click Setup to choose which fields are displayed in this area. Fields required 
by the data acquisition settings may be shown even if turned off here. Values with 
colored backgrounds are outside the normal operating range. See Setup→Limits. 

   Read this value directly from the hardware (Driver required). 

   Read this value directly from the hardware. Provide value to the field above. 

   Read this value directly from the hardware. This value and ones below it are 
provided to the field above. 

   This value must be entered manually. 

   This value must be entered manually. Provide value to the field above. 

  This value must be entered manually. This value and ones below it are 
provided to the field above. 

   Compute this field from the fields below. 

  This value must be entered manually. 

6. Set the pressure units and reference. Then enter the desired pressure. The Masses and 
Trim will be updated for the entered pressure. 

Gauge Pressure is referenced to atmosphere. Atmospheric pressure is defined as zero. 
A vacuum is a negative pressure. 

Absolute with Vacuum Ref. Pressure is referenced to vacuum. Absolute vacuum is 
defined as zero. Atmospheric pressure is a positive value. 

Absolute with Barometric Ref. Pressure is generated with the deadweight gauge in 
Gauge mode (referenced to atmospheric pressure). The pressure generated is corrected to 
reference vacuum using a Barometric reference sensor. The uncertainty of the barometric 
sensor must be included in the generated pressure uncertainty. 
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Very Low Gauge Pressure is generated with the deadweight gauge in Absolute mode 
(referenced to vacuum). The pressure generated is corrected to reference atmosphere 
using a Barometric reference sensor. The uncertainty of the barometric sensor must be 
included in the generated pressure uncertainty. 

7. Load the masses and trim indicated onto the deadweight gauge. Shows the required 
masses to generate the entered pressure. If no masses are shown or the field requests 
all masses be loaded, check piston and mass set selected and gravity value. 

  Turns on and off the trim calculation. The trim resolution can be set in Setup 
Units. 

8. Wait for stability. If data acquisition is being used, red shows unstable while green 
shows stable. The pressure stability curve is adjusted by modifying the pressure at 
which the maximum sink rate occurs and/or the sink rate at the full scale pressure. 
These values are then used to derive an equation for a curve that approximates the 
sink rate at various pressures. 

The Max Sink Rate and the Full Scale Pressure are defined in the selected Piston 
File. 

9. Enter Device Under Test reading and optional comment. The device under test and 
comment entries are displayed on the calibration report. The device under test 
reading is not converted when pressure units are changed. 

10. Click Accept  to save the information associated with the current pressure 
point. The actual pressure, the device under test reading, and the comment will be 
displayed in the accepted points window. After accepting, enter the next pressure 
point in Desired Pressure. 

11. Repeat Steps 4 through 10 for each point. 

12. Click Print  to print a report of the accepted pressure points. 

Advanced WinPrompt® Use 
Once WinPrompt® has been successfully installed, the user will have to set up a number 
of files and configure how WinPrompt® receives information. Most of this setup is 
performed rather infrequently, and is typically required only when a piston or mass set is 
being used for the first time, when a piston or mass set has been recalibrated, or when a 
procedure is being established or edited. After this initial setup of the *.PC, *.MS and 
*.PRC files, routine operation requires only the use of the *.CLB files. 

WinPrompt® uses four file types: 

*.PC  stores Piston/Cylinder (P/C) calibration coefficients; 

*.MS  stores Mass Set calibration coefficients; 

*.PRC  stores "PRoCedure" settings as a template for the *.CLB files (described 
below), such as data acquisition settings, view options, graph scaling, P/C and 
Mass selections, pressure units and sequence, and other parameters that will be 
constant for a given calibration procedure; 
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*.CLB  contains the working file for a given CaLiBration. Generally, a *.CLB file is 
generated from a *.PRC file, which already includes P/C and Mass selection, 
pressure sequence, etc., for a given calibration. Once the calibration is 
performed, the *.CLB file becomes a permanent record of the event. Typically, 
a new *.CLB file is used for every calibration performed and a unique file name 
should be assigned accordingly file.  

Advanced windows are created using the View menu. The windows can be moved by 
dragging the title bar or resized by dragging the borders. A typical advanced setup is 
shown in Figure 2-2. 

 
gma08.bmp 

Figure 2-2. Typical Advanced Setup 

Setup 
Enter Piston/Cylinder Information 

For each piston/cylinder assembly that has not yet been used with this installation of 
WinPrompt® the user must set up a *.PC file. 

1. Click  or from the menu select File→New. 

2. Select Piston/Cylinder and click OK. 

3. Fill in the Piston/Cylinder header information. 

4. Click View Details. 

5. Fill in the Piston/Cylinder detail information. 
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Note 

The value in the Apparent Mass Reference Density field must be the 
reference density of the Apparent Mass designation. If Apparent Mass 
versus Brass Standards is used, the Density value will typically be 
8400 kg/m3. If Apparent Mass versus Stainless Steel Standards is used, the 
Density value will typically be 8000 kg/m3. 

6. If uncertainty information is desired click Uncertainties, fill in the uncertainty 
information and click OK. No Uncertainty computations are performed within 
WinPrompt®. 

7. Click OK for the detail information. 

8. Click OK for the header information 

9. Click Yes to save changes. 

10. Enter the file name for the piston/cylinder. Click OK. 

11. Piston/Cylinder File has been created. 

Enter Mass Set Information 
For each mass set that has not yet been used with this installation of WinPrompt®, the 
user must setup a *.MS file. 

1. Click or from the menu select FILE→NEW. 

2. Select Mass Set and click OK. 

3. Fill in the Mass Set header information. 

4. Click VIEW DETAILS. 

5. Fill in the Mass Set detail information. 

Note 

The value in the Apparent Mass Reference Density field must be the 
reference density of the Apparent Mass designation. If Apparent Mass 
versus Brass Standards is used, the Density value will typically be 8400 
kg/m3. If Apparent Mass versus Stainless Steel Standards is used, the 
Density value will typically be 8000 kg/m3. 

Note 

The Sleeve Mass Offset is a correction to the FPI Sensor when the low mass 
sleeve is loaded by itself, or loaded with other masses. If the mass set 
includes the low mass version of the sleeve weight, then this value should be 
set to – 0.1016 cm, otherwise it should be set to 0.0 cm. 

6. For each mass in the set: 

a. Click ADD. 

b. Fill in the mass information. 

c. Click OK. 
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Note  

Enter the Apparent Mass Reference Density reported for the material the 
masses are made of (average density if made of more than one material) in 
the TRUE DENSITY field. If any individual mass does not load directly 
onto the deadweight gauge, enter the value of the required mass in the 
REQUIRES field (e.g. mass number 2 typically requires the hanger mass 
number 1; mass number 3 may also require number 1. The REQUIRES 
field defaults to mass number 1). 

7. Click OK for the detail information. 

8. Click OK for the header information. 

9. Click YES to save changes. 

10. Enter the file name for the mass set. Click OK. 

11. Mass Set File has been created. 

Create a Procedure Template 

1. Click  or from the menu select File→New. 

2. Select Procedure and click OK. 

3. Click  or from the menu select Standards→Standard 
Piston/Cylinder→Load. 

4. Select piston/cylinder file desired and click Open. 

5. Click  or from the menu select Standards→Standard Mass 

Set→Load. 

6. Select mass set file desired and click Open. 

7. Select from the menu Setup→Remote Acquisition. 

8. For each Deadweight Gauge A, Deadweight Gauge B and Ambient Variable to be 
received from an installed driver, set the Remote Acquisition field to Data 
Acquisition, otherwise, set it to constant.  

If the Air Density will be computed from the Ambient values, set the Air Density 
field to Formula, otherwise set it to Constant. If no value is known for the Local 
Gravity, set the Local Gravity field to Formula, otherwise set it to Constant. 

Note 

It is the user’s responsibility to know the Local Gravity value. No level of 
uncertainty is expressed or implied in the Formula computed value within 
WinPrompt®, and the value may vary greatly from a certified or surveyed 
value. 

9. Click OK. 

10. Select from the menu Setup→Process Variables. 

11. Enter the values for the variables that are not acquired remotely. 

12. If uncertainty information is desired, click Uncertainties, fill in the uncertainty 
information and click OK. No Uncertainty computations are performed within 
WinPrompt®. 

13. Click OK for the Process Variables. 
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14. Select from the menu Setup→Reference→ Media. 

15. Enter the reference and media information and click OK. 

a. If the Absolute with Vacuum Ref. mode is selected, enter the Expected Vacuum, 
typically 100 mTorr (13.33 Pa). If the Absolute with Barometer mode is selected, 
enter the Expected Barometer, typically 14.7 psi (101.35 kPa), then enter the 
Barometer Head Height. This value is used to correct for any head pressure that 
may exist between the barometer and the deadweight gauge. The polarity of the 
value will be positive if the barometer’s reference plane is higher than the float 
position marking the deadweight gauge. 

b. If the system includes a section filled with liquid, select the appropriate fluid in 
the OIL/MEDIUM field. Select other if system fluid is not listed. If other is 
selected, enter the density of the fluid in the density field. If the Absolute with 
Barometer mode is selected, enter the height of the offset between the test 
instrument reference plane and the marking on the deadweight gauge used to 
establish the proper float position. The polarity of the value will be positive if the 
test instrument reference plane is higher than the float position marking the 
deadweight gauge. 

c. If the system includes a section filled with gas, select the appropriate fluid in the 
GAS/MEDIUM field. Select other if system fluid is not listed. If other is 
selected, enter the density of the fluid in the density field. Enter the height of the 
offset between the test instrument reference plane and the marking on the 
deadweight gauge used to establish the proper float position. The polarity of this 
value will be positive if the test instrument reference plane is higher than the float 
position marking the deadweight gauge. 

16. Click  or from the menu select Calibration→Sequence. 

17. Click Generate. 

18. Enter the full scale of the test instrument and the number of increasing and 
decreasing steps. Entering 10 points up will result in a pressure sequence of 10% 
increments of full scale.  

19. Click Generate. 

20. Click OK for the test sequence. 

21. Click  or from the menu select View→All. Each window can be resized, 
repositioned, minimized or closed to suit the desire of the operator. These new 
window settings will be saved with the other procedure attributes in the *.PRC file. 

22. Click  or from the menu select File→Save As. 

23. Enter the file name for the procedure and click Save.  

24. Procedure File has been created. 

Perform a Calibration 

1. Click  or from the menu select File→New. 

2. Select Calibration and click OK. 

3. Select procedure file desired and click Open. 

4. From the menu, select Setup→Device Under Test. Enter the test instrument 
description and click OK. 
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5. Verify the first point is highlighted in the Pressure to Mass Window or the 
Calibration Window by clicking on the first point. 

6. Load the masses and trim (as applicable), establish the pressure and monitor the 
deadweight Gauge until the system is stable. 

7. Once the system is stable, click , double-click the point in the Calibration 
Window, or from the menu select Calibration→Accept. 

8. Enter the DUT reading and click OK. 

9. WinPrompt® will store the entered test instrument information and numerous other 
deadweight gauge parameters with each point recorded. 

10. Repeat Steps 5 through 9 for each point in the pressure sequence. 

11. Click  or from the menu select File→Save As. 

12. Enter the file name for the calibration and click Open. 

13. Click  or from the menu select File→Print to print the default calibration report.
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Chapter 3 
File Menu 

Create New File 
The Create New File command brings up the Create New dialog box to select the type of 
file to create. 

Note 

Any previously open file is automatically closed. If changes to the previous 
file have been made and not saved, the user is prompted to save the 
changes. 

 
gko_007.bmp 

Figure 3-1. Create New Screen 

Insert File 
When a new Calibration File is created, the Insert File dialog box prompts the user for a 
Procedure File as a template. Select a procedure template or click on Cancel to create 
the Calibration File without a template. 

 
gko_001.bmp 

Figure 3-2. Insert File Screen 
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Open Existing File 
Opens an existing file for viewing or editing. The default is to list calibration files. Use 
the Files of Type box to list other file types. 

Look in Select the drive and directory from which to display files. 

File Name Type or select the filename to be opened. 

Files of Type Allows display of calibration files, procedures files, mass set files or 
piston/cylinder files. 

Note 

Any previously open file is automatically closed. If changes to the previous 
file have been made and not saved, the user is prompted to save the 
changes. 

 
gko_002.bmp 

Figure 3-3. Open Existing File Dialog Box 

Close File 
Closes the currently open file and closes all windows. If changes to the file have been 
made and not saved the user is prompted to save the changes. If password protection is 
used, the password must be entered before changes will be saved. 

Save File 
Saves all changes made to the currently open file back to the file that was opened. To 
save the contents to a different location, use Save File As. If the file is new, Save File, 
is equivalent to Save File As. 

Save File As 
Saves all changes open file under a different name or to give a name to a new file. The 
currently open file is saved to the name entered in the dialog box. The Save File As 
Type can be used to save only part of a file (e.g., save a calibration file as a procedure 
file to be used as a template for new calibration files). 

Save In Select the drive and directory to which to write the current file. 

File Name Type or select the filename to name the current file. 

Save as Type Saves file as a calibration file, procedure file, mass set file or 
piston/cylinder file. Only the data corresponding to the file type will 
be saved. 
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gko_003.bmp 

Figure 3-4. Save File As Dialog Box 

Set Password  
Piston/Cylinder, Mass Set and Procedure Files can be password protected. After 
assigning a password to a file, the user must enter the password for all subsequent file 
saves until the password is removed. No password is required to use the file in a 
calibration. 

New Password  Enter a new password. 

Verify Password  Enter the new password again to confirm. The New Password 
and Verify Password fields must match before the password may 
be changed. 

Remove Password The previous password must be entered to remove the password.  

 
gko_004.bmp 

Figure 3-5. Password Protect Dialog Box 

Copy to Clipboard 
Copies the selected item in the Variables Window to the clipboard. Click an item in the 
Variables Window, select File Copy To Clipboard. The value or link may then be pasted 
into other applications. 
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Print Setup  
Allows the user to select the printer to be used and other options for the printer selected. 
Only installed printers are listed; see your Windows documentation for information on 
installing printers. 

 
gko_005.bmp 

Figure 3-6. Print Setup Dialog Box 

Print 
Prints the default Calibration Report. Click Properties button to set print options. 
A word processor or spreadsheet application can be used to create customer reports. 
See Chapter 4, Dynamic Data Exchange (DDE). 

 
gko_006.bmp 

Figure 3-7. Print Screen 

Exit 
Exits from WinPrompt®. All windows are closed. If changes have been made and not 
saved, the user is prompted to save the file. 
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Chapter 4 
View Menu

Variables Window 
Displays the current values of the input variables and the calculated values for the current 
point. Stores the current value for input variables and calculated values for each point in 
the pressure sequence at the time the point is "accepted". (Refer to Chapter 7.) See the 
Glossary for definitions of variables. 

 
gko_052.bmp 

Figure 4-1. Variables Window 

Pressure to Mass Window 
Displays the pressure points in the current sequence and the identification of the masses 
needed to generate the pressure. The pressure sequence may be changed with the 
Calibration/Sequence command. If no masses are listed, the required load is less than 
the smallest mass in the selected mass set. 

The highlighted line indicates the current pressure point. Use the mouse or the arrow keys 
to change the current pressure point. Changing the current pressure point also affects the 
Calibration Window. 

 
gko_053.bmp 

Figure 4-2. Pressure to Mass Window 
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Mass to Pressure Conversion 
Used to determine the pressure for a given mass load. 

Enter the masses and the program will computer the pressure. It can also be used as a 
quick way to edit individual pressure points within a sequence. 

The dialog box is activated only by double-clicking on a pressure point in the Pressure 
to Mass Window. Edited pressure points are displayed in a different color in the 
Pressure to Mass Window. 

Pressure When the pressure value is edited, the masses are recomputed and 
the trim is set to zero. 

Edit When the masses are edited (by clicking on Edit) the pressure is 
recomputed from the specified masses and trim. 

Trim When the trim is edited, the pressure is re-computed from the 
specified masses and trim. 

Calculate If Calculate is clicked, the trim is recomputed for the specified 
pressure. 

 
gko_060.bmp 

Figure 4-3. Mass to Pressure Conversion Window 

Calibration Window 
The highlighted line indicates the current pressure point. Use mouse or arrow keys to 
move highlight. Changing current pressure point also affects Pressure to Mass 
Window. Double-click a pressure point to display Accept Point dialog. (See 
Chapter 7, Accept Calibration Point) 

 
gko_055.bmp 

Figure 4-4. Calibration Window 



 View Menu 
 Current Point Data Window 4 

4-3 

Seq. Pressure Sequence. 

Trim (g) The trim required for this point. This value can be changed by 
Compute Trim, Zero Trim, Zero All Trims, or Mass to Pressure. 
The resolution of the trim is set in the Setup/Units form. 

Actual The actual pressure at the DUT. If the point has been accepted, the 
pressure recorded is displayed. If it has not been accepted, the 
current point shows the actual pressure corrected for current 
conditions. All other points show the requested pressure. 
(Non cross-float only.) 

Reading The DUT reading as entered on the Accept Point dialog box. If the 
point has not been accepted no value will be shown. 
(Non cross-float only.) 

Std Mass The total mass loaded on the Standard DWG. (Cross-float only). 

Test Mass The total mass loaded on the Test DWG. (Cross-float only). 

Comment The comment entered on the Accept Point dialog box. 

The highlighted line indicates the current pressure point. Use the mouse or the arrow keys 
to move the highlight. Changing the current pressure point also affects the Pressure to 
Mass window. 

Double-click a pressure point to display the Accept Point dialog. (See Chapter 7) 

Current Point Data Window 
Displays an array of edit boxes showing current point data (gray boxes), or allowing the 
editing of constant point data (clear boxes), as selected in the Setup | Remote Acquisition 
menu. Both columns A and B are displayed. Double-clicking the form will display a 
setup screen. 

 
gko_056.bmp 

Figure 4-5. Current Point Data Window 

Setup displays a list of available values that can be shown in the Current Point Data 
window. Checking the box will display that value. The Dwg B column is displayed only 
when Cross-Float is selected on the Setup menu. 
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Figure 4-6. Setup Current Point Screen 

Float Position Indicator 
Displays a bar graph showing the current float position. Both float positions are displayed 
in cross-float mode. Double-click the window to change the limits of the bar graph. When 
Float Position Indicator is set to constant, (see Chapter 6, Setup Remote Acquisition), the 
graph will change to a lighter color. 

 
gko_058.bmp 

Figure 4-7. Float Position Indicator Window 



 View Menu 
 Float Position Graph 4 

4-5 

Float Position Graph 
Displays a line graph showing the float position versus elapsed time (seconds). In 
cross-float mode, both float positions are displayed. Double-click the window to change 
the limits of the graph. 

 
gko_059.bmp 

Figure 4-8. Float Position Graph Window 

Sink Rate Graph 
Displays a line graph showing the piston sink rate versus elapsed time (seconds). Both 
sink rates are displayed in cross-float mode. Double-click the window to change the 
limits of the graph. 

Temperature Graph 
Displays a line graph showing the Deadweight gauge temperature versus elapsed time 
(seconds). Both temperatures are displayed in cross-float mode. Double-click the window 
to change the limits of the graph. 

Other Graph 
Displays a line graph showing other Deadweight gauge sensor indicators, such as 
barometric pressure, relative humidity, air density, or vacuum. 

View All Windows 
Opens all available windows and tiles them to fit on the screen. 

Dynamic Data Exchange (DDE) 
To use values from WinPrompt® in another application: 

1. Open the Variables Window. 

2. Click with the left mouse button to select a label, value, or unit name. 

3. Click on COPY on the speed bar. (See Appendix A.) 
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4. Switch to the other application. 

5. Select PASTE to insert the selected value. 

-or- 

Select PASTE LINK to insert a link to the value. The value will be updated every 
time WinPrompt® changes the value. 
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Chapter 5 
Standards Menu 

Standard Piston/Cylinder 
View Standard Piston/Cylinder 

Allows the user to view the Standard piston/cylinder information. 

View Piston/Cylinder 
Contains all information for the Standard piston/cylinder currently loaded for use in the 
calibration. 

This information can only be edited when a piston/cylinder file is opened. See Chapter 3, 
Open Existing File. 

 
gko_008.bmp 

Figure 5-1. Piston/Cylinder Data Screen 

Edit Piston/Cylinder Header 
Allows editing of the piston/cylinder header information used for reports and displays. 
Click View Details to edit piston/cylinder specifics. 

 
gko_009.bmp 

Figure 5-2. Piston/Cylinder Window 
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Edit Piston/Cylinder Data 
Contains all critical information for the Standard piston/cylinder currently loaded for use 
in the calibration. 

 
gko_010.bmp 

Figure 5-3. View Details in Piston/Cylinder Data Dialog Box 

Edit Piston/Cylinder Uncertainties 
Enter the uncertainties for the piston/cylinder parameters. This information can be used 
via DDE in a spreadsheet application to compute the uncertainty of the calibration. 

 
gko_011.bmp 

Figure 5-4. Piston/Cylinder Data Uncertainties Dialog Box 

Load Standard Piston/Cylinder 
Allows the user to select the piston/cylinder file from their database that containing the 
information for the Standard  

Print Standard Piston/Cylinder 
Prints the definition of the piston/cylinder loaded for the Standard DWG. 

Standard Mass Set 
View Standard Mass Set 

Allows user to view the Standard mass set information.  

Contains all critical information for Standard mass set currently loaded for use in the 
calibration. 

This information can only be edited when a mass set file is opened. See Chapter 3, Open 
Existing File.  
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Figure 5-5. Mass Set Data Window 

Edit Mass Set Header 
Once a mass set file is open, this dialog box allows editing of the mass set header 
information used for reports and displays. Click on View Details to edit mass 
set specifics. 

 
gko_013.bmp 

Figure 5-6. Mass Set Dialog Box 

Edit Mass Set 
Contains all critical information for the Standard mass set currently loaded for use in the 
calibration. 

The Apparent Mass Reference Density is the unit of apparent mass of the selected 
mass values. There are two common unit of measure for Apparent Mass. One is Apparent 
Mass verses Stainless Steel, which has a reference density of 8.0 g/cm3 and the other is 
Apparent Mass verses Brass, which has a reference density of 8.4 g/cm3. On the RUSKA 
calibration report, these are denoted as Amass8.0 for Apparent Mass Verses Stainless 
and Amass8.4 for Apparent Mass verses Brass. If the mass values are selected from the 
Amass8.0 table of the calibration report, then with the unit of measurement for density 
set to g/cm3 the Apparent Mass Reference Density valve should be set to 8.0 g/cm3. If the 
mass values are selected from the Amass8.4 table of the calibration report, then with the 
unit of measurement for density set to g/cm3, the Apparent Mass Reference Density 
valve should be set to 8.4 g/cm3.   
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When the float position of the piston is being monitored by a 2465 Autofloat or a 2456 
Piston Gauge Monitor, the 2-piece low mass sleeve weight will indicate a different float 
position based on the other larger masses being loaded, and resting at the bottom of the 
sleeve mass. The Sleeve Mass Offset corrects for this offset. The default value is 
-4.000e-02 in (-1.016e-03 m) when used with either of the 2465A-799 or 2468A-799 
mass sets. All other mass sets should have this value set to zero. 

Click on a mass with the mouse to highlight it and then click on: 

 Edit Edit specifics of highlighted mass. 

 Add Add new mass to the end of the list. 

 Insert Add new mass before the highlighted mass. 

 Delete Removes the highlighted mass from the mass set. 
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Figure 5-7. Edit Mass Set Data Dialog Box 

Edit Mass 
If Edit, Add or Insert is selected, this dialog box allows the mass calibration 
information to be entered or edited. 
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Figure 5-8. Edit Mass Dialog Box 

Load Standard Mass Set 
Allows the user to select the mass set file from their database that contains information 
for the mass set for the Standard to be used in the calibration. 

Print Standard Mass Set 
Prints the definition of the mass set loaded for the Standard DWG. 
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Test Piston/Cylinder 
View Test Piston/Cylinder 

Contains all critical information for the Test piston/cylinder currently loaded for use in 
the calibration. 

Load Test Piston/Cylinder 
Allows the user to select the piston/cylinder file from their database that contains the 
information for the Test piston/cylinder to be used in the calibration. 

The only piston/cylinder fields that are required for the Test piston/cylinder are True 
Mass tare for Absolute calibrations and Apparent Mass Tare and Density for Gauge 
calibrations. 

Print Test Piston/Cylinder 
Prints the definition of the piston/cylinder loaded for the Test Deadweight Gauge. 

Test Mass Set 
View Test Mass Set 

Contains all critical information for the Test mass set currently loaded for use in the 
calibration. 

Load Test Mass Set 
Allows the user to select the mass set file from their database that contains the 
information for the Test mass set to be used in the calibration. 

Print Test Mass Set 
Prints the definition of the mass set loaded for the Test DWG. 
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Chapter 6 
Setup Menu 

Setup Units 
Allows the selection of units for display of values. 

 
gko_016.bmp 

Figure 6-1. Units Window 

Table 6-1. Units for Display of Values 

UNIT FIELD AFFECTS 

Pressure Pressure values. 

Decimals Number of decimals for pressure values. 

Mass Mass values (excluding trim mass) 

Trim Trim mass. 

Density Density of Ambient Air, Oil, Gas 

Trim Resolution Trim Mass Round-off Resolution 

Gravity Gravity values 

Temperature Temperatures, c 

Vacuum Reference pressure 

Head Height Head heights, Float position, Sink rate 
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Table 6-1. Units for Display of Values, cont. 

UNIT FIELD AFFECTS 

Area Piston area, b1, b2, c 

Std. Pressure b1, b2 

Length L1, D 

Elevation Elevation 

 
The Set SI Units and Set Default Units can be used to set all units to a standard map. 

Table 6-2. SI and Default Units 

 Set SI Units Set Default Units 

Pressure MPa Psi 

Decimals Unchanged Unchanged 

Mass Kg lbm 

Trim g g 

Density kg/m3 lb/in3 

Trim Resolution kg/m3 lb/in3 

Gravity m/sec2 ft/sec2 

Temperature oC oC 

Vacuum Pa micron 

Head Height cm in 

Area m2 in2 

Std. Pressure MPa psi 

Length m in 

Elevation m ft 

Setup Device Under Test 
Allows entry of Device Under Test description to record the device calibrated. Fields are 
labeled for common usage. None of these fields is required. 
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Figure 6-2. Device Under Test Dialog Box 
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Setup Cross-Float 
Turns on and off cross-float support. When a check mark appears next to the menu 
option, cross-float support is turned on. Cross-float support toggles each time this menu 
item is selected. 

Checked Calibration of a Deadweight gauge against another Deadweight gauge.  
All DWG B fields are enabled. 

Unchecked Calibration of any pressure gauge against a Deadweight gauge.  
All DWG B fields are disabled. 

Setup Remote Acquisition 
Controls whether each input variable is read by data acquisition or a constant value 
is used. 

Data Acquisition Updated in real-time by remote driver. 

Data Acq.—Average  Updated in real-time by remote driver averaging dual FPI 
inputs. 

Formula   Computed from other values. (Air Density is from Ambient 
temperature, Humidity, and Pressure. Gravity is computed 
from Elevation and Latitude. Gravity formula is not 
recommended.) 

Constant   Entered in Process Variables, Current Point Data Window, or 
Single Point Window. 

Same As A   This value for Deadweight Gauge B will use the same value as 
defined for Deadweight Gauge A. 

 
gko_018.bmp 

Figure 6-3. Remote Acquisition Dialog Box 

Edit Process Variables 
Edit the constant values for input variables. Editing is only allowed if the variable has 
been defined as Constant in Set Up→Remote Acquisition (Chapter 6, Setup Remote 
Acquisition). 
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Figure 6-4. Process Variables Window 

Process Variable Uncertainties 
Enter the uncertainties for the process variables. All values may be entered whether the 
variable is defined as Constant or Data Acquisition. 

 
gko_020.bmp 

Figure 6-5. Process Variable Uncertainties Window 

Edit Reference and Media 
For Absolute mode with a Vacuum Reference, select Absolute with Vacuum Ref and 
enter the Expected Vacuum. The expected vacuum is used to calculate the masses and 
trim needed so that the masses may be loaded before the vacuum is applied to the 
Deadweight Gauge. 

For Absolute mode with a Barometer, select Absolute with Barometer and 

Winprompt
®

 will add the current ambient pressure to the deadweight gauge pressure 
reading. This allows a “gauge” mode only deadweight gauge to operate in the absolute 
mode by inputting or reading the current barometric pressure. This can be entered as a 
constant or collected by data acquisition, depending on the specific setup for the unit.  
When defined as a constant (Ambient/Pressure field in the Remote Acquisition form, 
(Chapter 6, Setup Remote Acquisition), the current barometric pressure reading will need 
to be entered. Note that this is the same value that appears in the Ambient/Pressure field 
in the Process Variable form (Chapter 6, Edit Process Variables). 
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The Barometer Head Height is the vertical height between the barometer and the 
reference plane of the deadweight gauge, when a remote barometer is used.  

Head correction is provided for oil and gas, and for systems with both oil and gas. If the 
system does not have both, the other Medium should be set to None and the Head 
Height to zero. Standard media are provided, or the medium may be set to Other and 
the Density entered directly. 

Provision is made to enter a head correction for Zero pressure points for oil systems.  
When operating in an oil medium, a value may be entered for the column head height 
between the reference plane of the Device Under Test (DUT) and the physical location 
where the system is vented to atmosphere when zeroing the DUT. Enter the height 
difference in the DUT field, and select the Above/Below button to indicate the relative 
position of the DUT to the controller. 

Gauge mode is used to generate pressures referenced to atmosphere. Positive pressures 
are generated with the top of the deadweight gauge open to atmosphere. This mode also 
supports negative gauge with the bottom of the piston connected to atmosphere and the 
bell jar installed on top with a pressure below atmosphere. 

Very Low Gauge mode is used to generate gauge pressures very close to atmospheric 
pressure or for negative gauge pressures. When operating in this mode, the deadweight 
gauge is physically operated in the absolute mode. The first point that is generated in the 
pressure table is a pressure point used to align the internal Auto-float’s barometer. This 
corrected barometric pressure reading is then subtracted from the deadweight gauge 
readings for the remainder of the pressure points used in the calibration. This initial point 
is designated as “R” in the sequence column of the Pressure-to-Mass and Calibration 
windows.  

  The Device Under Test is above the standard. 

  The Device Under Test is below the standard. 

  The barometer is above the standard. 

  The barometer is below the standard. 

  The Device Under Test is above the reservoir level. 

  The Device Under Test is below the reservoir level. 
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Figure 6-6. Reference Media Window 

To start the calibration: 

1. Double click on the first sequence labeled as “R” in the Pressure-to-Mass 
window.  

2. Type the reading from the internal barometric reference sensor as the desired 
pressure in the Mass/Pressure Conversion pop up window and hit Enter or 
select Ok. This value should be obtained from the bottom, center section of the main 
WinPrompt screen. It should show the current barometric reading followed by Abs 
Ref. label.  

3. Click trim icon to calculate the proper trim mass value and load the mass and trim 
mass onto the deadweight gauge.  

4. Place the bell jar onto the instrument base and Autofloat this pressure.  

5. Once a stable pressure has been obtained, double click on the first sequence labeled 
“R” in the Calibration window. The value for the internal barometer will 
automatically be shown in this “Accept” window. Click Ok. WinPrompt® will 
calculate the other masses required in the remainder of the procedure.  

Limits 
Lists variables that have maximum and minimum allowable values that may be set by the 
user. Some of these values are verified when data is entered by the user; others are 
verified when a point is accepted or verified as needed as the program runs.  

Edit   Minimum and Maximum values for selected variable may be changed. 

Factory  Returns selected variable to Factory defaults. 

Factory All  Returns all variables to Factory defaults. 
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Install/Remove Communications Drivers 
WinPrompt® supports several interfaces to Ruska deadweight gauges that can provide 
data acquisition, real-time graphing, and auto-float control. See Appendix D for more 
information on specific drivers. 

Installing a Driver 
1. Remove all drivers from Installed Drivers list. 

2. Select driver to be installed from Available Drivers list. 

3. Click Install. 

4. Click OK when complete. 

Removing a Driver 
1. Select driver to be removed from Installed Drivers list. 

2. Click Delete. 

3. Click OK when complete 

 
gko022.bmp 

Figure 6-7. Communication Drivers Window 

Setup Window 
The Setup Window command is equivalent to double-clicking the current window. A 
dialog box is displayed according to current window type. 

Setup Graph Window 
Allows changing of graph variable and limits. 

 
gko_030.bmp 

Figure 6-8. Configure Graph Window 
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Setup Float Position Indicator 
Allows setting range of indicator graph. Graph limits are plus and minus the maximum 
value. Additionally, graph scale can be either Linear or Logarithmic to give more 
resolution at mid-float. 

 
gko_031.bmp 

Figure 6-9. Configure Indicator Window 
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Chapter 7 
Calibration Menu 

Introduction 
The Calibration menu includes functions for adding and deleting pressure points, 
computing and clearing trims, and accepting and clearing calibrations. 

Accept Calibration Point 
Displays one of two dialog boxes depending on the setting of the cross float flag: 

• Accept Point (Non-Cross-Float) 
• Accept Point (Cross-Float) 

Accept Point (Non-Cross-Float) 
When the sink rate and float position have stabilized and the data point is ready to be 
recorded: 

1. Select Accept Point from the Calibration menu or double-click on the Current 
Pressure Calibration window. 

2. A dialog box will appear requesting the reading of the device under test. A short 
comment on the details of that data point may be included. The comment field is 
limited to 44 characters and will be saved with the data. When the pressure is 0, the 
DUT line is displayed. This is identical to the DUT line in the Oil section of the 
Reference/Media setup screen. 

3. Choose OK and the data box will close. 

4. WinPrompt® will index to the next indicated data point. 
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Figure 7-1. Accept Window 
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Accept Point (Cross-Float) 
Allows user to edit the masses and trim used on both the Test and Standard Deadweight 
Gauges. Use Change Masses buttons to correct the list of masses used. Enter the 
correct values and an optional comment, and click on OK to capture all the data 
associated with the calibration point. 

 
gko_033.bmp 

Figure 7-2. Accept Point (Cross-Float) Dialog Box 

Change Masses 
Displays two lists: Used Masses are the masses currently selected as loaded; Available 
Masses are the rest of the masses in the Mass Set. 
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Figure 7-3. Standard Masses Window 

To Load a Mass: 
1. Highlight the mass by clicking it. 

2. Click Insert. 

3. Click Ok when complete 

To Remove a Mass: 
1. Highlight the mass by clicking it with the mouse. 

2. Click Delete. 

3. Click Ok when complete 
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Compute Trim 
Click on a data point in the Calibration Window. Actual pressure resulting from 
application of the list of masses indicated in the Pressure to Mass Window will be 
displayed based on the current ambient conditions. To generate the requested pressure, 
additional Trim Mass may be required. This trim is determined by selecting Compute 
Trim in the Calibration Menu. 

The Compute Trim command returns the value of the trim mass necessary to generate 
the requested pressure at the current ambient conditions using the masses calculated for 
that pressure and displayed in the Pressure to Mass Window. 

The trim mass is selectable for one data point entry at a time. This provides for changes 
in ambient conditions as the test sequence progresses. 

The trim mass required is displayed in the Calibration Window. It is listed to the left of 
the actual pressure. 

Zero Trim 
Removes calculated Trim Mass value for the current data point. This returns the actual 
pressure to the value generated from application of the list of masses indicated in 
Pressure to Mass Window. 

Zero Trim will not be allowed once Accept Point has been activated for a test sequence 
data point. 

Edit Pressure Sequence Definition 
Edits the pressure sequence used in calibration. Click to highlight a pressure point before 
using Edit, Insert, or Delete. 

Description Name or comment to identify the pressure sequence. 

Point List of pressures currently in the pressure sequence. 

Generate Use automatic generation to define the pressure points. 

Edit Change pressure of the selected point. 

Add Add a new pressure to the end of the sequence. 

Insert Insert a new pressure before the selected point. 

Delete Delete the current point. 

 
gko_035.bmp 

Figure 7-4. Test Sequence Dialog Box 
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Edit Pressure Point 
This dialog box is used to enter the pressure for each point in the pressure sequence. See 
Edit Pressure Sequence Definition. 

Generate Sequence 
Generate Sequence is used to automatically generate a pressure sequence from 0 to Full 
Scale Pressure. The sequence has Points Up points from 0 to Full Scale Pressure 
and Points Down points from Full Scale Pressure back to 0. 

Example: 

Full Scale Pressure 100 

Points Up  4 

Points Down  2 

Generates 7 points: 0, 25, 50, 75, 100, 50, 0. 

Note 

All previous defined points in the pressure sequence are deleted when 
Generate is pressed. 

 
gko_036.bmp 

Figure 7-5. Generate Sequence Dialog Box 

Zero All Trims 
Removes all of the calculated trim mass values for each of the test sequence data points. 

This selection will be grayed-out and is not available once a data point has been accepted 
in the test sequence. 

Clear Accepted Calibration Point 
Removes an accepted data point from the accepted list. Click on the line in the 
Calibration Window. Choose Clear Point, click Ok to verify the removal. The 
sequence point is then available for input of new data. 

Clear All Accepted Calibration Points 
Removes all of the accepted data for a test sequence. Click Ok to verify and mark all 
points as not accepted. 
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Chapter 8 
Windows Menu 

Arrange Windows Overlapping 
Resizes and layers open windows so that each title bar is visible. 

Arrange Windows Non-Overlapping 
Resizes and arranges the open windows side by side. 

Arrange Minimized Windows 
Arranges minimized windows in a row along the bottom of the screen. 

Large Toolbar Buttons 
Toggles between large and small toolbar buttons. 

Graph Line Width 
Sets the width of the line used for graphs. 

Close All Windows 
The Close All Windows command closes all open windows. 
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Chapter 9 

Help Menu 

Introduction 
Displays help and version information. 

Contents 
Displays the Help File contents page. 

Wizard 
Starts the Initial Setup Wizard. See Chapter 1. 

About WinPrompt® 
Displays current installed version of WinPrompt® and copyright notice as well as 
versions of active drivers.
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Appendix A 
Speed Bar and Formula

Speed Bar 
Provides shortcuts to the most frequently used menu items. Position the mouse cursor 
over the icon for text label. 

Table A-1. Speed Bar Icon and Description 

Icon Description Icon Description 

 
Create New File    

 
Compute Trim    

 
Open Existing File 

 
Zero Trim    

 
Save File   

 
Accept Calibration Point    

 
Copy to Clipboard    

 
Zero All Trims 

 
Print   

 
Start Auto-Float    

 
View Piston/Cylinder 

 
Pressurize System 

 
View Mass Set   

 
Vent Pressure    

 
Edit Pressure Sequence 
Definition  

Stop Auto-Float 

 
View All Windows   
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Formulas 
The formulas used in WinPrompt® are listed for information and verification. Remember 
to include units when verifying formulas. Formulas may reference other formulas and 
variables found in the glossary. 

Pressure to Mass 
The conversion from pressure to mass is used to compute the necessary masses and trim. 
Certain variables may use expected values instead of actual values where the actual value 
is expected to change significantly. 

Calculate Corrected Pressure (kPa) 

1000)( xPPPPP REFGHOHc −++=  

Convert Corrected Pressure to Mass (kg) 

( ) ( )
( ) 8101

12
211 −−

−+++=
xxG

TTxc
ccoc

MREFD
AIRD

REFxPxbPxbxAxPM  

Mass to Pressure 
Calculate Pressure from Mass (kPa) 

( ) ( )
o

MASSD
AIRD

REFTTxc
M

A

xxGx

DP
8

1 101 −
−+ −

=
 

Correct Pressure 

OHGHREFPxbPxb

P PPPxP
DD

D −−+=
++

10002
211  

Head Pressure 
Corrects for reference plane offsets. 

Head Pressures with Gas at Piston (kPa) 

( )( ) 80665.9100 xDxHxDLHP GASFPIGASGH −−+=  

80665.9xDxHP OILOILOH =  

Head Pressures with Oil at Piston (kPa) 

80665.9xDxHP GASGASGH =  

( )( ) 80665.9100 xDxHxDLHP OILFPIOILOH −−+=  
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Gas Density (g/cm3) 
WinPrompt® includes formulas for common gases based on pressure since the density of 
a gas varies significantly with pressure. 

Nitrogen Gas Density below 6895 kPa (1000 psia) 

PxxDGAS
5101347.1 −=  

Nitrogen Gas Density from 6895 kPa (1000 psia) to 103400 kPa (15000 psia) 

35211 10573.6101016.1105087.5 −−− ++−= xPxxPxxDGAS  

Zero Air Gas Density below 20680 kPa (3000 psia) 

PxxDGAS
51017.1 −=  

Helium Gas Density below 689.5 kPa (1000 psia) 

PxxDGAS
610585.1 −=  

Helium Gas Density from 689.5 kPa (1000 psia) to 103400 kPa (15000 psia) 

46212 10136.310508.110886.3 −−− ++−= xPxxPxxDGAS  

Oil Density (g/cm3) 
Spinesstic 22 

 0.858 g/cm3 

DOS Sebacate 

 0.913 g/cm3 

Reference Pressure (kPa) 
The Reference pressure must be corrected since Absolute vacuum is not achieved and atmosphere 
must be corrected for head heights. 

Absolute Readings: 

The reference pressure for Absolute readings is the current vacuum level.  

Gauge Readings: 

80665.9xHxDP AIRREF =  

Mass 
Apparent mass is corrected for air buoyancy in positive gauge mode. Absolute mode uses 
true mass without buoyancy correction. Negative gauge mode uses true mass but corrects 
for air buoyancy. 
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Total Mass 

iTARE mMM +=  

MASS

AIR

PISTON

AIR

APPTARE

D

D
D

D

MM
−

−
×=

1

1
 

True Mass and Apparent Mass 

( )
( )

TRUED
AIRD
REFD
AIRD

xMM APPTRUE −

−
=

1

1

 

( )
( )

REFD
AIRD

TRUED
AIRD

xMM TRUEAPP −

−
=

1

1
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Appendix B 
Error Messages 

Error Messages 
WinPrompt® error messages are listed in alphabetic order below with additional 
information. 

Table B-1. Error Messages 

Error Description 

<Filename> has changed. Save Changes? The file specified has unsaved changes and you have either tried to 
exit WinPrompt® or open a different file.   

Press Yes to save the changes or No to discard the changes. 

<New File> has changed.  Save changes? A new file has been created. User has either tried to exit 
WinPrompt® or open a different file.   

Press Yes to save the changes or No to discard the changes. 

Apparent Mass Reference Density must not 
be zero. 

Converting between Apparent Mass and True Mass requires a valid 
Apparent Mass Reference Density. 

Calibration point already cleared. The calibration point specified to be cleared was already cleared. 

Calibration point has been accepted and 
cannot be changed. 

Once a point has been accepted it cannot be changed unless the 
point is cleared.   

See Clear Calibration Point. 

Cannot save Piston or Mass Set Link. Procedure files only contain references to the Piston and Mass Set 
therefore, Save As cannot be used to save a Procedure file as a 
Piston or Mass Set file. 

Clear Accepted Calibration Point? Requests confirmation before the highlighted calibration point is 
cleared. 

Clear All Accepted Calibration Points? Requests confirmation before all calibration points are cleared. 

Error Loading <Filename> or one of its 
dependents.  

The driver could not be loaded. Verify that the driver is in the same 
directory as WinPromp.exe Any IEEE-488 driver requires the 
GPIB.DLL driver.  

Error writing to file. The complete file could not be written. Check to make sure the disk 
is not full. 
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Table B-2. Error Messages, cont. 

Error Description 

File <Filename> already exists.  Overwrite? The file name entered in Save As already exists.   

Press Yes to overwrite the file. 

Incorrect Password. The password entered is not correct. The correct password must be 
entered before opening a protected file. 

Invalid File Format <Filename>.  The file is either corrupted or from a previous version. 

Invalid Mass Set Data (CRC). The Mass Set information has been corrupted.   

Verify the Mass Set before using. 

Invalid Mass Set File <Filename>. The Mass Set file specified is invalid. 

Invalid Mass Set Link (CRC). The Mass Set reference in the procedure file is invalid. 

Invalid Piston/Cylinder Data (CRC).  The Piston information has been corrupted.   

Verify the Piston before using. 

Invalid Piston/Cylinder File <Filename>.   The Piston file specified is invalid. 

Invalid Piston/Cylinder Link (CRC)....   The Piston reference in the procedure file is invalid. 

Maximum Number of points is <numbers>.   A test sequence cannot have more than the specified number of 
pressure points. 

Nothing to save for this file type. Save As was used to save the file in a different format but the 
loaded file contains no information to save in the requested format.  
(e.g., Saving a Piston file as a Mass Set file.) 

Out of Timers.  Windows does not have a timer available. The graph windows will 
not update. Shutdown other applications and restart WinPrompt®.  

Password Verify must match New Password. The two fields must match before the password is changed. 

Reference must be calibrated and accepted 
first.  

The current point cannot be accepted because the reference point 
(listed first) must be accepted first to calibrate the reference sensor 
before any other point may be accepted. Select the reference point, 
float the pressure, and accept the point. Then other points can be 
accepted. 

Serial Port Not Available Error (<code>).  The serial port requested is in use by another application.   

Shut down the other application or use a different serial port. 

True Density must not be zero.  Converting between Apparent Mass and True Mass requires a valid 
True Mass.  

Unable to Start Print. The printer could not be started.   

Check your printer driver and setup then try printing again. 

Unable to write to file. The file could not be created. Verify rights are available to write to 
the disk and try the save again.  
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Appendix C 
Dynamic Data Exchange (DDE) 

Dynamic Data Exchange (DDE) 
The following DDE commands may be inserted into Excel to pull values from 
WinPrompt®. 

Table C-1. Dynamic Data Exchange (DDE) 

Topic Field DDE Command Output Sample 

Unit    

 Mass =WinPrompt|Unit!Mass lbm 

 Length =WinPrompt|Unit!Length in 

 Standard =WinPrompt|Unit!Standard psi 

 C =WinPrompt|Unit!'C' in²/in²/°C 

 b1 =WinPrompt|Unit!'b1' in²/in²/psi 

 b2 =WinPrompt|Unit!'b2' in²/in²/psi² 

 Ao =WinPrompt|Unit!Ao in² 

 Trim =WinPrompt|Unit!Trim g 

 Gravity =WinPrompt|Unit!Gravity ft/sec² 

 Head =WinPrompt|Unit!Head in 

 SinkRate =WinPrompt|Unit!SinkRate in/min 

 Elevation =WinPrompt|Unit!Elevation ft 

 Density =WinPrompt|Unit!Density lb/in³ 

 Vacuum =WinPrompt|Unit!Vacuum microns 

 Temp =WinPrompt|Unit!Temp °C 

 Humidity =WinPrompt|Unit!Humidity % 

 Pressure =WinPrompt|Unit!Pressure psi 
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Topic Field DDE Command Output Sample 

Piston    

 Model =WinPrompt|Piston!Model 1-Eng 

 Serial =WinPrompt|Piston!Serial 1 

 Description =WinPrompt|Piston!Description English Units Test Piston 

 CalDate =WinPrompt|Piston!CalDate 01/01/1996 

 CalBy =WinPrompt|Piston!CalBy Ruska 

 CalRef =WinPrompt|Piston!CalRef E-12 

 Comment =WinPrompt|Piston!Comment 0 

 TareApp =WinPrompt|Piston!TareApp 0.84 

 TareTrue =WinPrompt|Piston!TareTrue 0.84 

 Ao =WinPrompt|Piston!Ao 1 

 b1 =WinPrompt|Piston!’b1’ 0.001 

 b2 =WinPrompt|Piston!’b2’ 0.00001 

 c =WinPrompt|Piston!’c’ 0.000015 

 L =WinPrompt|Piston!L 8 

 Density =WinPrompt|Piston!Density 0.4 

 Medium =WinPrompt|Piston!Medium Oil 

 MedDensity =WinPrompt|Piston!MedDensity 0 

 RefTemp =WinPrompt|Piston!RefTemp 23 

 MaxSink =WinPrompt|Piston!MaxSink 30 

 MaxPress =WinPrompt|Piston!MaxPress 2400 

 TareAppUnc =WinPrompt|Piston!TareAppUnc 0.001 

 TareTrueUnc =WinPrompt|Piston!TareTrueUnc 0.001 

 AoUnc =WinPrompt|Piston!AoUnc 0.00000001 

 b1Unc =WinPrompt|Piston!b1Unc 0.001 

 b2Unc =WinPrompt|Piston!b2Unc 0.001 

 cUnc =WinPrompt|Piston!cUnc 0.001 

 LUnc =WinPrompt|Piston!Lunc 0.01 

 DensityUnc =WinPrompt|Piston!DensityUnc 0.0001 
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Topic Field DDE Command Output Sample 

MassSet    

 Model =WinPrompt|MassSet!Model 1-Eng 

 Serial =WinPrompt|MassSet!Serial 1 

 Description =WinPrompt|MassSet!Description English Standard  

Mass Set 

 CalDate =WinPrompt|MassSet!CalDate 03/25/1996 

 CalBy =WinPrompt|MassSet!CalBy Ruska 

 CalRef =WinPrompt|MassSet!CalRef E-1 

 Comment =WinPrompt|MassSet!Comment 0 

 D =WinPrompt|MassSet!D 0.3937 

 Density =WinPrompt|MassSet!Density 0.2818 

 Count =WinPrompt|MassSet!Count 13 

 DUnc =WinPrompt|MassSet!Dunc 39.37 

Masses    

1 MassID =WinPrompt|Masses!’MassID[0]’ 1 

2 MassID =WinPrompt|Masses!’MassID[1]’ 2 

3 MassID =WinPrompt|Masses!’MassID[2]’ 3 

4 MassID =WinPrompt|Masses!’MassID[3]’ 4 

5 MassID =WinPrompt|Masses!’MassID[4]’ 5 

6 MassID =WinPrompt|Masses!’MassID[5]’ 6 

7 MassID =WinPrompt|Masses!’MassID[6]’ 7 

8 MassID =WinPrompt|Masses!’MassID[7]’ 8 

9 MassID =WinPrompt|Masses!’MassID[8]’ 9 

10 MassID =WinPrompt|Masses!’MassID[9]’ 10 

1 MassApp =WinPrompt|Masses!’MassApp[0]’ 0.5 

2 MassApp =WinPrompt|Masses!’MassApp[1]’ 1 

3 MassApp =WinPrompt|Masses!’MassApp[2]’ 1 

4 MassApp =WinPrompt|Masses!’MassApp[3]’ 1 

5 MassApp =WinPrompt|Masses!’MassApp[4]’ 1 

6 MassApp =WinPrompt|Masses!’MassApp[5]’ 1 

7 MassApp =WinPrompt|Masses!’MassApp[6]’ 0.5 

8 MassApp =WinPrompt|Masses!’MassApp[7]’ 0.3999999 

9 MassApp =WinPrompt|Masses!’MassApp[8]’ 0.2 

10 MassApp =WinPrompt|Masses!’MassApp[9]’ 0.1 
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Topic Field DDE Command Output Sample 

1 MassTrue =WinPrompt|Masses!’MassTrue[0]’ 0.5 

2 MassTrue =WinPrompt|Masses!’MassTrue[1]’ 1 

3 MassTrue =WinPrompt|Masses!’MassTrue[2]’ 1 

4 MassTrue =WinPrompt|Masses!’MassTrue[3]’ 1 

5 MassTrue =WinPrompt|Masses!’MassTrue[4]’ 1 

6 MassTrue =WinPrompt|Masses!’MassTrue[5]’ 1 

7 MassTrue =WinPrompt|Masses!’MassTrue[6]’ 0.5 

8 MassTrue =WinPrompt|Masses!’MassTrue[7]’ 0.3999999 

9 MassTrue =WinPrompt|Masses!’MassTrue[8]’ 0.2 

10 MassTrue =WinPrompt|Masses!’MassTrue[9]’ 0.1 

1 MassRequires =WinPrompt|Masses!’MassRequires[0]’ (none) 

2 MassRequires =WinPrompt|Masses!’MassRequires[1]’ 1 

3 MassRequires =WinPrompt|Masses!’MassRequires[2]’ 2 

4 MassRequires =WinPrompt|Masses!’MassRequires[3]’ 3 

5 MassRequires =WinPrompt|Masses!’MassRequires[4]’ 4 

6 MassRequires =WinPrompt|Masses!’MassRequires[5]’ 5 

7 MassRequires =WinPrompt|Masses!’MassRequires[6]’ 1 

8 MassRequires =WinPrompt|Masses!’MassRequires[7]’ 1 

9 MassRequires =WinPrompt|Masses!’MassRequires[8]’ 1 

10 MassRequires =WinPrompt|Masses!’MassRequires[9]’ 1 

1 MassDensity =WinPrompt|Masses!’MassDensity[0]’ 0.3999 

2 MassDensity =WinPrompt|Masses!’MassDensity[1]’ 0.3999 

3 MassDensity =WinPrompt|Masses!’MassDensity[2]’ 0.3999 

4 MassDensity =WinPrompt|Masses!’MassDensity[3]’ 0.3999 

5 MassDensity =WinPrompt|Masses!’MassDensity[4]’ 0.3999 

6 MassDensity =WinPrompt|Masses!’MassDensity[5]’ 0.3999 

7 MassDensity =WinPrompt|Masses!’MassDensity[6]’ 0.3999 

8 MassDensity =WinPrompt|Masses!’MassDensity[7]’ 0.3999 

9 MassDensity =WinPrompt|Masses!’MassDensity[8]’ 0.3999 

10 MassDensity =WinPrompt|Masses!’MassDensity[9]’ 0.3999 

1 MassUnc =WinPrompt|Masses!’MassUnc[0]’ 2.20462E-08 

2 MassUnc =WinPrompt|Masses!’MassUnc[1]’ 2.20462E-08 

3 MassUnc =WinPrompt|Masses!’MassUnc[2]’ 2.20462E-08 

4 MassUnc =WinPrompt|Masses!’MassUnc[3]’ 2.20462E-08 



 Dynamic Data Exchange (DDE) 
 Dynamic Data Exchange (DDE) C 

C-5 

Topic Field DDE Command Output Sample 

5 MassUnc =WinPrompt|Masses!’MassUnc[4]’ 2.20462E-08 

6 MassUnc =WinPrompt|Masses!’MassUnc[5]’ 2.20462E-08 

7 MassUnc =WinPrompt|Masses!’MassUnc[6]’ 2.20462E-08 

8 MassUnc =WinPrompt|Masses!’MassUnc[7]’ 2.20462E-08 

9 MassUnc =WinPrompt|Masses!’MassUnc[8]’ 2.20462E-08 

10 MassUnc =WinPrompt|Masses!’MassUnc[9]’ 2.20462E-08 

PistonB    

 Model =WinPrompt|PistonB!Model 1-Metric 

 Serial =WinPrompt|PistonB!Serial 1 

 Description =WinPrompt|PistonB!Description Metric Standard Piston 

 CalDate =WinPrompt|PistonB!CalDate 01/01/1996 

 CalBy =WinPrompt|PistonB!CalBy Ruska 

 CalRef =WinPrompt|PistonB!CalRef E-12 

 Comment =WinPrompt|PistonB!Comment 0 

 TareApp =WinPrompt|PistonB!TareApp 2.204623 

 TareTrue =WinPrompt|PistonB!TareTrue 2.204623 

 Ao =WinPrompt|PistonB!Ao 0.1550003 

 b1 =WinPrompt|PistonB!’b1’ 0.0000689 

 b2 =WinPrompt|PistonB!’b2’ 4.75E-07 

 c =WinPrompt|PistonB!’c’ 0.000015 

 L =WinPrompt|PistonB!L 11.81 

 Density =WinPrompt|PistonB!Density 0.3613 

 Medium =WinPrompt|PistonB!Medium Oil 

 MedDensity =WinPrompt|PistonB!MedDensity 0 

 RefTemp =WinPrompt|PistonB!RefTemp 23 

 MaxSink =WinPrompt|PistonB!MaxSink 29.528 

 MaxPress =WinPrompt|PistonB!MaxPress 2900.754 

 TareAppUnc =WinPrompt|PistonB!TareAppUnc 0.02204623 

 TareTrueUnc =WinPrompt|PistonB!TareTrueUnc 0.02204623 

 AoUnc =WinPrompt|PistonB!AoUnc 0.001550003 

 b1Unc =WinPrompt|PistonB!b1Unc 0.00000689 

 b2Unc =WinPrompt|PistonB!b2Unc 4.75E-08 
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Topic Field DDE Command Output Sample 

 cUnc =WinPrompt|PistonB!cUnc 0.001 

 LUnc =WinPrompt|PistonB!Lunc 0.003937 

 DensityUnc =WinPrompt|PistonB!DensityUnc 3.613E-09 

MassSetB    

 Model =WinPrompt|MassSetB!Model 1-Metric 

 Serial =WinPrompt|MassSetB!Serial 1 

 Description =WinPrompt|MassSetB!Description Metric Standard Mass Set 

 CalDate =WinPrompt|MassSetB!CalDate 03/25/1996 

 CalBy =WinPrompt|MassSetB!CalBy Ruska 

 CalRef =WinPrompt|MassSetB!CalRef E-1 

 Comment =WinPrompt|MassSetB!Comment 0 

 D =WinPrompt|MassSetB!D 0.394 

 Density =WinPrompt|MassSetB!Density 0.2818 

 Count =WinPrompt|MassSetB!Count 14 

 Dunc =WinPrompt|MassSetB!Dunc 39.37 

MassesB    

1 MassID =WinPrompt|MassesB!’MassID[0]’ 1 

2 MassID =WinPrompt|MassesB!’MassID[1]’ 2 

3 MassID =WinPrompt|MassesB!’MassID[2]’ 3 

4 MassID =WinPrompt|MassesB!’MassID[3]’ 4 

5 MassID =WinPrompt|MassesB!’MassID[4]’ 5 

6 MassID =WinPrompt|MassesB!’MassID[5]’ 6 

7 MassID =WinPrompt|MassesB!’MassID[6]’ 7 

8 MassID =WinPrompt|MassesB!’MassID[7]’ 8 

9 MassID =WinPrompt|MassesB!’MassID[8]’ 9 

10 MassID =WinPrompt|MassesB!’MassID[9]’ 10 

1 MassApp =WinPrompt|MassesB!’MassApp[0]’ 1.102311 

2 MassApp =WinPrompt|MassesB!’MassApp[1]’ 2.204623 

3 MassApp =WinPrompt|MassesB!’MassApp[2]’ 2.204623 

4 MassApp =WinPrompt|MassesB!’MassApp[3]’ 2.204623 

5 MassApp =WinPrompt|MassesB!’MassApp[4]’ 2.204623 

6 MassApp =WinPrompt|MassesB!’MassApp[5]’ 2.204623 

7 MassApp =WinPrompt|MassesB!’MassApp[6]’ 1.102311 

8 MassApp =WinPrompt|MassesB!’MassApp[7]’ 0.6613868 



 Dynamic Data Exchange (DDE) 
 Dynamic Data Exchange (DDE) C 

C-7 

Topic Field DDE Command Output Sample 

9 MassApp =WinPrompt|MassesB!’MassApp[8]’ 0.4409245 

10 MassApp =WinPrompt|MassesB!’MassApp[9]’ 0.2204623 

1 MassTrue =WinPrompt|MassesB!’MassTrue[0]’ 1.102311 

2 MassTrue =WinPrompt|MassesB!’MassTrue[1]’ 2.204623 

3 MassTrue =WinPrompt|MassesB!’MassTrue[2]’ 2.204623 

4 MassTrue =WinPrompt|MassesB!’MassTrue[3]’ 2.204623 

5 MassTrue =WinPrompt|MassesB!’MassTrue[4]’ 2.204623 

6 MassTrue =WinPrompt|MassesB!’MassTrue[5]’ 2.204623 

7 MassTrue =WinPrompt|MassesB!’MassTrue[6]’ 1.102311 

8 MassTrue =WinPrompt|MassesB!’MassTrue[7]’ 0.6613868 

9 MassTrue =WinPrompt|MassesB!’MassTrue[8]’ 0.4409245 

10 MassTrue =WinPrompt|MassesB!’MassTrue[9]’ 0.2204623 

1 MassRequires =WinPrompt|MassesB!’MassRequires[0]’ (none) 

2 MassRequires =WinPrompt|MassesB!’MassRequires[1]’ 1 

3 MassRequires =WinPrompt|MassesB!’MassRequires[2]’ 2 

4 MassRequires =WinPrompt|MassesB!’MassRequires[3]’ 3 

5 MassRequires =WinPrompt|MassesB!’MassRequires[4]’ 4 

6 MassRequires =WinPrompt|MassesB!’MassRequires[5]’ 5 

7 MassRequires =WinPrompt|MassesB!’MassRequires[6]’ 1 

8 MassRequires =WinPrompt|MassesB!’MassRequires[7]’ 1 

9 MassRequires =WinPrompt|MassesB!’MassRequires[8]’ 1 

10 MassRequires =WinPrompt|MassesB!’MassRequires[9]’ 1 

1 MassDensity =WinPrompt|MassesB!’MassDensity[0]’ 0.2818 

2 MassDensity =WinPrompt|MassesB!’MassDensity[1]’ 0.2818 

3 MassDensity =WinPrompt|MassesB!’MassDensity[2]’ 0.2818 

4 MassDensity =WinPrompt|MassesB!’MassDensity[3]’ 0.2818 

5 MassDensity =WinPrompt|MassesB!’MassDensity[4]’ 0.2818 

6 MassDensity =WinPrompt|MassesB!’MassDensity[5]’ 0.2818 

7 MassDensity =WinPrompt|MassesB!’MassDensity[6]’ 0.2818 

8 MassDensity =WinPrompt|MassesB!’MassDensity[7]’ 0.2818 

9 MassDensity =WinPrompt|MassesB!’MassDensity[8]’ 0.2818 

10 MassDensity =WinPrompt|MassesB!’MassDensity[9]’ 0.2818 

1 MassUnc =WinPrompt|MassesB!’MassUnc[0]’ 2.20462E-08 

2 MassUnc =WinPrompt|MassesB!’MassUnc[1]’ 2.20462E-08 
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Topic Field DDE Command Output Sample 

3 MassUnc =WinPrompt|MassesB!’MassUnc[2]’ 2.20462E-08 

4 MassUnc =WinPrompt|MassesB!’MassUnc[3]’ 2.20462E-08 

5 MassUnc =WinPrompt|MassesB!’MassUnc[4]’ 2.20462E-08 

6 MassUnc =WinPrompt|MassesB!’MassUnc[5]’ 2.20462E-08 

7 MassUnc =WinPrompt|MassesB!’MassUnc[6]’ 2.20462E-08 

8 MassUnc =WinPrompt|MassesB!’MassUnc[7]’ 2.20462E-08 

9 MassUnc =WinPrompt|MassesB!’MassUnc[8]’ 2.20462E-08 

10 MassUnc =WinPrompt|MassesB!’MassUnc[9]’ 2.20462E-08 

Procedure    

 Description =WinPrompt|Procedure!Description Test Sequence 

 Count =WinPrompt|Procedure!Count 15 

 Reference =WinPrompt|Procedure!Reference Gauge 

 OilMedium =WinPrompt|Procedure!OilMedium (none) 

 GasMedium =WinPrompt|Procedure!GasMedium (none) 

 OilHead =WinPrompt|Procedure!OilHead 0 

 GasHead =WinPrompt|Procedure!GasHead 0 

 OilDensity =WinPrompt|Procedure!OilDensity 0 

 GasDensity =WinPrompt|Procedure!GasDensity 0 

 OilDensityUnc =WinPrompt|Procedure!OilDensityUnc 0 

 GasDensityUnc =WinPrompt|Procedure!GasDensityUnc 0 

 OilHeadUnc =WinPrompt|Procedure!OilHeadUnc 0 

 GasHeadUnc =WinPrompt|Procedure!GasHeadUnc 0 

 DwgAFPIUnc =WinPrompt|Procedure!DwgAFPIUnc 0.001 

 DwgATempUnc =WinPrompt|Procedure!DwgATempUnc 0.1 

 DwgAVacuumUnc =WinPrompt|Procedure!DwgAVacuumUnc 1 

 DwgBFPIUnc =WinPrompt|Procedure!DwgBFPIUnc 0.001 

 DwgBTempUnc =WinPrompt|Procedure!DwgBTempUnc 0.1 

 DwgBVacuumUnc =WinPrompt|Procedure!DwgBVacuumUnc 1 

 TempUnc =WinPrompt|Procedure!TempUnc 1 

 HumidityUnc =WinPrompt|Procedure!HumidityUnc 3 

 BarometerUnc =WinPrompt|Procedure!BarometerUnc 0.1 

 AirDensityUnc =WinPrompt|Procedure!AirDensityUnc 0.00003 

 GravityUnc =WinPrompt|Procedure!GravityUnc 9.84252E-07 
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Sequence    

1 Pressure =WinPrompt|Sequence!'Pressure[0]' 1.5 

2 Pressure =WinPrompt|Sequence!'Pressure[1]' 1.75 

3 Pressure =WinPrompt|Sequence!'Pressure[2]' 2 

4 Pressure =WinPrompt|Sequence!'Pressure[3]' 2.25 

5 Pressure =WinPrompt|Sequence!'Pressure[4]' 2.5 

6 Pressure =WinPrompt|Sequence!'Pressure[5]' 2.75 

7 Pressure =WinPrompt|Sequence!'Pressure[6]' 3 

8 Pressure =WinPrompt|Sequence!'Pressure[7]' 3.25 

9 Pressure =WinPrompt|Sequence!'Pressure[8]' 3.5 

10 Pressure =WinPrompt|Sequence!'Pressure[9]' 3.75 

Calibration    

 Model =WinPrompt|Calibration!Model 0 

 Serial =WinPrompt|Calibration!Serial 0 

 Description =WinPrompt|Calibration!Description 0 

 Comment =WinPrompt|Calibration!Comment 0 

 Pressure =WinPrompt|Calibration!Pressure 0 

CalDwgA    

1 FPI =WinPrompt|CalDwgA!'FPI[0]' 0.01 

2 FPI =WinPrompt|CalDwgA!'FPI[1]' 0.01 

3 FPI =WinPrompt|CalDwgA!'FPI[2]' 0.01 

4 FPI =WinPrompt|CalDwgA!'FPI[3]' 0.01 

5 FPI =WinPrompt|CalDwgA!'FPI[4]' 0.01 

6 FPI =WinPrompt|CalDwgA!'FPI[5]' 0.01 

7 FPI =WinPrompt|CalDwgA!'FPI[6]' 0.01 

8 FPI =WinPrompt|CalDwgA!'FPI[7]' 0.01 

9 FPI =WinPrompt|CalDwgA!'FPI[8]' 0.01 

10 FPI =WinPrompt|CalDwgA!'FPI[9]' 0.01 

1 Temp =WinPrompt|CalDwgA!'Temp[0]' 30 

2 Temp =WinPrompt|CalDwgA!'Temp[1]' 30 

3 Temp =WinPrompt|CalDwgA!'Temp[2]' 30 

4 Temp =WinPrompt|CalDwgA!'Temp[3]' 30 

5 Temp =WinPrompt|CalDwgA!'Temp[4]' 30 

6 Temp =WinPrompt|CalDwgA!'Temp[5]' 30 
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7 Temp =WinPrompt|CalDwgA!'Temp[6]' 30 

8 Temp =WinPrompt|CalDwgA!'Temp[7]' 30 

9 Temp =WinPrompt|CalDwgA!'Temp[8]' 30 

10 Temp =WinPrompt|CalDwgA!'Temp[9]' 30 

1 Vacuum =WinPrompt|CalDwgA!'Vacuum[0]' 100 

2 Vacuum =WinPrompt|CalDwgA!'Vacuum[1]' 100 

3 Vacuum =WinPrompt|CalDwgA!'Vacuum[2]' 100 

4 Vacuum =WinPrompt|CalDwgA!'Vacuum[3]' 100 

5 Vacuum =WinPrompt|CalDwgA!'Vacuum[4]' 100 

6 Vacuum =WinPrompt|CalDwgA!'Vacuum[5]' 100 

7 Vacuum =WinPrompt|CalDwgA!'Vacuum[6]' 100 

8 Vacuum =WinPrompt|CalDwgA!'Vacuum[7]' 100 

9 Vacuum =WinPrompt|CalDwgA!'Vacuum[8]' 100 

10 Vacuum =WinPrompt|CalDwgA!'Vacuum[9]' 100 

1 SinkRate =WinPrompt|CalDwgA!'SinkRate[0]' 0 

2 SinkRate =WinPrompt|CalDwgA!'SinkRate[1]' 0 

3 SinkRate =WinPrompt|CalDwgA!'SinkRate[2]' 0 

4 SinkRate =WinPrompt|CalDwgA!'SinkRate[3]' 0 

5 SinkRate =WinPrompt|CalDwgA!'SinkRate[4]' 0 

6 SinkRate =WinPrompt|CalDwgA!'SinkRate[5]' 0 

7 SinkRate =WinPrompt|CalDwgA!'SinkRate[6]' 0 

8 SinkRate =WinPrompt|CalDwgA!'SinkRate[7]' 0 

9 SinkRate =WinPrompt|CalDwgA!'SinkRate[8]' 0 

10 SinkRate =WinPrompt|CalDwgA!'SinkRate[9]' 0 

1 Rotation =WinPrompt|CalDwgA!'Rotation[0]' CW 

2 Rotation =WinPrompt|CalDwgA!'Rotation[1]' CW 

3 Rotation =WinPrompt|CalDwgA!'Rotation[2]' CW 

4 Rotation =WinPrompt|CalDwgA!'Rotation[3]' CW 

5 Rotation =WinPrompt|CalDwgA!'Rotation[4]' CW 

6 Rotation =WinPrompt|CalDwgA!'Rotation[5]' CW 

7 Rotation =WinPrompt|CalDwgA!'Rotation[6]' CW 

8 Rotation =WinPrompt|CalDwgA!'Rotation[7]' CW 

9 Rotation =WinPrompt|CalDwgA!'Rotation[8]' CW 

10 Rotation =WinPrompt|CalDwgA!'Rotation[9]' CW 
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CalDwgB    

1 FPI =WinPrompt|CalDwgB!'FPI[0]' 0.02 

2 FPI =WinPrompt|CalDwgB!'FPI[1]' 0.02 

3 FPI =WinPrompt|CalDwgB!'FPI[2]' 0.02 

4 FPI =WinPrompt|CalDwgB!'FPI[3]' 0.02 

5 FPI =WinPrompt|CalDwgB!'FPI[4]' 0.02 

6 FPI =WinPrompt|CalDwgB!'FPI[5]' 0.02 

7 FPI =WinPrompt|CalDwgB!'FPI[6]' 0.02 

8 FPI =WinPrompt|CalDwgB!'FPI[7]' 0.02 

9 FPI =WinPrompt|CalDwgB!'FPI[8]' 0.02 

10 FPI =WinPrompt|CalDwgB!'FPI[9]' 0.02 

1 Temp =WinPrompt|CalDwgB!'Temp[0]' 31 

2 Temp =WinPrompt|CalDwgB!'Temp[1]' 31 

3 Temp =WinPrompt|CalDwgB!'Temp[2]' 31 

4 Temp =WinPrompt|CalDwgB!'Temp[3]' 31 

5 Temp =WinPrompt|CalDwgB!'Temp[4]' 31 

6 Temp =WinPrompt|CalDwgB!'Temp[5]' 31 

7 Temp =WinPrompt|CalDwgB!'Temp[6]' 31 

8 Temp =WinPrompt|CalDwgB!'Temp[7]' 31 

9 Temp =WinPrompt|CalDwgB!'Temp[8]' 31 

10 Temp =WinPrompt|CalDwgB!'Temp[9]' 31 

1 Vacuum =WinPrompt|CalDwgB!'Vacuum[0]' 110 

2 Vacuum =WinPrompt|CalDwgB!'Vacuum[1]' 110 

3 Vacuum =WinPrompt|CalDwgB!'Vacuum[2]' 110 

4 Vacuum =WinPrompt|CalDwgB!'Vacuum[3]' 110 

5 Vacuum =WinPrompt|CalDwgB!'Vacuum[4]' 110 

6 Vacuum =WinPrompt|CalDwgB!'Vacuum[5]' 110 

7 Vacuum =WinPrompt|CalDwgB!'Vacuum[6]' 110 

8 Vacuum =WinPrompt|CalDwgB!'Vacuum[7]' 110 

9 Vacuum =WinPrompt|CalDwgB!'Vacuum[8]' 110 

10 Vacuum =WinPrompt|CalDwgB!'Vacuum[9]' 110 

1 SinkRate =WinPrompt|CalDwgB!'SinkRate[0]' 0 

2 SinkRate =WinPrompt|CalDwgB!'SinkRate[1]' 0 

3 SinkRate =WinPrompt|CalDwgB!'SinkRate[2]' 0 
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4 SinkRate =WinPrompt|CalDwgB!'SinkRate[3]' 0 

5 SinkRate =WinPrompt|CalDwgB!'SinkRate[4]' 0 

6 SinkRate =WinPrompt|CalDwgB!'SinkRate[5]' 0 

7 SinkRate =WinPrompt|CalDwgB!'SinkRate[6]' 0 

8 SinkRate =WinPrompt|CalDwgB!'SinkRate[7]' 0 

9 SinkRate =WinPrompt|CalDwgB!'SinkRate[8]' 0 

10 SinkRate =WinPrompt|CalDwgB!'SinkRate[9]' 0 

1 Rotation =WinPrompt|CalDwgB!'Rotation[0]' CW 

2 Rotation =WinPrompt|CalDwgB!'Rotation[1]' CW 

3 Rotation =WinPrompt|CalDwgB!'Rotation[2]' CW 

4 Rotation =WinPrompt|CalDwgB!'Rotation[3]' CW 

5 Rotation =WinPrompt|CalDwgB!'Rotation[4]' CW 

6 Rotation =WinPrompt|CalDwgB!'Rotation[5]' CW 

7 Rotation =WinPrompt|CalDwgB!'Rotation[6]' CW 

8 Rotation =WinPrompt|CalDwgB!'Rotation[7]' CW 

9 Rotation =WinPrompt|CalDwgB!'Rotation[8]' CW 

10 Rotation =WinPrompt|CalDwgB!'Rotation[9]' CW 

CalData    

1 Temp =WinPrompt|CalData!'Temp[0]' 27 

2 Temp =WinPrompt|CalData!'Temp[1]' 27 

3 Temp =WinPrompt|CalData!'Temp[2]' 27 

4 Temp =WinPrompt|CalData!'Temp[3]' 27 

5 Temp =WinPrompt|CalData!'Temp[4]' 27 

6 Temp =WinPrompt|CalData!'Temp[5]' 27 

7 Temp =WinPrompt|CalData!'Temp[6]' 27 

8 Temp =WinPrompt|CalData!'Temp[7]' 27 

9 Temp =WinPrompt|CalData!'Temp[8]' 27 

10 Temp =WinPrompt|CalData!'Temp[9]' 27 

1 Humidity =WinPrompt|CalData!'Humidity[0]' 65 

2 Humidity =WinPrompt|CalData!'Humidity[1]' 65 

3 Humidity =WinPrompt|CalData!'Humidity[2]' 65 

4 Humidity =WinPrompt|CalData!'Humidity[3]' 65 

5 Humidity =WinPrompt|CalData!'Humidity[4]' 65 

6 Humidity =WinPrompt|CalData!'Humidity[5]' 65 
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7 Humidity =WinPrompt|CalData!'Humidity[6]' 65 

8 Humidity =WinPrompt|CalData!'Humidity[7]' 65 

9 Humidity =WinPrompt|CalData!'Humidity[8]' 65 

10 Humidity =WinPrompt|CalData!'Humidity[9]' 65 

1 Barometer =WinPrompt|CalData!'Barometer[0]' 14.7 

2 Barometer =WinPrompt|CalData!'Barometer[1]' 14.7 

3 Barometer =WinPrompt|CalData!'Barometer[2]' 14.7 

4 Barometer =WinPrompt|CalData!'Barometer[3]' 14.7 

5 Barometer =WinPrompt|CalData!'Barometer[4]' 14.7 

6 Barometer =WinPrompt|CalData!'Barometer[5]' 14.7 

7 Barometer =WinPrompt|CalData!'Barometer[6]' 14.7 

8 Barometer =WinPrompt|CalData!'Barometer[7]' 14.7 

9 Barometer =WinPrompt|CalData!'Barometer[8]' 14.7 

10 Barometer =WinPrompt|CalData!'Barometer[9]' 14.7 

1 AirDensity =WinPrompt|CalData!'AirDensity[0]' 0.00004214 

2 AirDensity =WinPrompt|CalData!'AirDensity[1]' 0.00004214 

3 AirDensity =WinPrompt|CalData!'AirDensity[2]' 0.00004214 

4 AirDensity =WinPrompt|CalData!'AirDensity[3]' 0.00004214 

5 AirDensity =WinPrompt|CalData!'AirDensity[4]' 0.00004214 

6 AirDensity =WinPrompt|CalData!'AirDensity[5]' 0.00004214 

7 AirDensity =WinPrompt|CalData!'AirDensity[6]' 0.00004214 

8 AirDensity =WinPrompt|CalData!'AirDensity[7]' 0.00004214 

9 AirDensity =WinPrompt|CalData!'AirDensity[8]' 0.00004214 

10 AirDensity =WinPrompt|CalData!'AirDensity[9]' 0.00004214 

1 Gravity =WinPrompt|CalData!'Gravity[0]' 32.1044 

2 Gravity =WinPrompt|CalData!'Gravity[1]' 32.1044 

3 Gravity =WinPrompt|CalData!'Gravity[2]' 32.1044 

4 Gravity =WinPrompt|CalData!'Gravity[3]' 32.1044 

5 Gravity =WinPrompt|CalData!'Gravity[4]' 32.1044 

6 Gravity =WinPrompt|CalData!'Gravity[5]' 32.1044 

7 Gravity =WinPrompt|CalData!'Gravity[6]' 32.1044 

8 Gravity =WinPrompt|CalData!'Gravity[7]' 32.1044 

9 Gravity =WinPrompt|CalData!'Gravity[8]' 32.1044 

10 Gravity =WinPrompt|CalData!'Gravity[9]' 32.1044 
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1 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[0]' 0 

2 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[1]' 0 

3 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[2]' 0 

4 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[3]' 0 

5 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[4]' 0 

6 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[5]' 0 

7 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[6]' 0 

8 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[7]' 0 

9 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[8]' 0 

10 LatitudeDeg =WinPrompt|CalData!'LatitudeDeg[9]' 0 

1 LatitudeMin =WinPrompt|CalData!'LatitudeMin[0]' 0 

2 LatitudeMin =WinPrompt|CalData!'LatitudeMin[1]' 0 

3 LatitudeMin =WinPrompt|CalData!'LatitudeMin[2]' 0 

4 LatitudeMin =WinPrompt|CalData!'LatitudeMin[3]' 0 

5 LatitudeMin =WinPrompt|CalData!'LatitudeMin[4]' 0 

6 LatitudeMin =WinPrompt|CalData!'LatitudeMin[5]' 0 

7 LatitudeMin =WinPrompt|CalData!'LatitudeMin[6]' 0 

8 LatitudeMin =WinPrompt|CalData!'LatitudeMin[7]' 0 

9 LatitudeMin =WinPrompt|CalData!'LatitudeMin[8]' 0 

10 LatitudeMin =WinPrompt|CalData!'LatitudeMin[9]' 0 

1 Elevation =WinPrompt|CalData!'Elevation[0]' 0 

2 Elevation =WinPrompt|CalData!'Elevation[1]' 0 

3 Elevation =WinPrompt|CalData!'Elevation[2]' 0 

4 Elevation =WinPrompt|CalData!'Elevation[3]' 0 

5 Elevation =WinPrompt|CalData!'Elevation[4]' 0 

6 Elevation =WinPrompt|CalData!'Elevation[5]' 0 

7 Elevation =WinPrompt|CalData!'Elevation[6]' 0 

8 Elevation =WinPrompt|CalData!'Elevation[7]' 0 

9 Elevation =WinPrompt|CalData!'Elevation[8]' 0 

10 Elevation =WinPrompt|CalData!'Elevation[9]' 0 

1 StdTrim =WinPrompt|CalData!'StdTrim[0]' 7.207 

2 StdTrim =WinPrompt|CalData!'StdTrim[1]' 7.861 

3 StdTrim =WinPrompt|CalData!'StdTrim[2]' 8.574 

4 StdTrim =WinPrompt|CalData!'StdTrim[3]' 0.276 
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5 StdTrim =WinPrompt|CalData!'StdTrim[4]' 1.11 

6 StdTrim =WinPrompt|CalData!'StdTrim[5]' 2.005 

7 StdTrim =WinPrompt|CalData!'StdTrim[6]' 2.962 

8 StdTrim =WinPrompt|CalData!'StdTrim[7]' 3.98 

9 StdTrim =WinPrompt|CalData!'StdTrim[8]' 5.061 

10 StdTrim =WinPrompt|CalData!'StdTrim[9]' 6.205 

1 TestTrim =WinPrompt|CalData!'TestTrim[0]' 7.207 

2 TestTrim =WinPrompt|CalData!'TestTrim[1]' 7.861 

3 TestTrim =WinPrompt|CalData!'TestTrim[2]' 8.574 

4 TestTrim =WinPrompt|CalData!'TestTrim[3]' 0.276 

5 TestTrim =WinPrompt|CalData!'TestTrim[4]' 1.11 

6 TestTrim =WinPrompt|CalData!'TestTrim[5]' 2.005 

7 TestTrim =WinPrompt|CalData!'TestTrim[6]' 2.962 

8 TestTrim =WinPrompt|CalData!'TestTrim[7]' 3.98 

9 TestTrim =WinPrompt|CalData!'TestTrim[8]' 5.061 

10 TestTrim =WinPrompt|CalData!'TestTrim[9]' 6.205 

1 Reading =WinPrompt|CalData!'Reading[0]' 0 

2 Reading =WinPrompt|CalData!'Reading[1]' 0 

3 Reading =WinPrompt|CalData!'Reading[2]' 0 

4 Reading =WinPrompt|CalData!'Reading[3]' 0 

5 Reading =WinPrompt|CalData!'Reading[4]' 0 

6 Reading =WinPrompt|CalData!'Reading[5]' 0 

7 Reading =WinPrompt|CalData!'Reading[6]' 0 

8 Reading =WinPrompt|CalData!'Reading[7]' 0 

9 Reading =WinPrompt|CalData!'Reading[8]' 0 

10 Reading =WinPrompt|CalData!'Reading[9]' 0 

1 Actual =WinPrompt|CalData!'Actual[0]' 1.5 

2 Actual =WinPrompt|CalData!'Actual[1]' 1.75 

3 Actual =WinPrompt|CalData!'Actual[2]' 2 

4 Actual =WinPrompt|CalData!'Actual[3]' 2.25 

5 Actual =WinPrompt|CalData!'Actual[4]' 2.5 

6 Actual =WinPrompt|CalData!'Actual[5]' 2.75 

7 Actual =WinPrompt|CalData!'Actual[6]' 3 

8 Actual =WinPrompt|CalData!'Actual[7]' 3.25 
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9 Actual =WinPrompt|CalData!'Actual[8]' 3.5 

10 Actual =WinPrompt|CalData!'Actual[9]' 3.75 

1 StdMass =WinPrompt|CalData!'StdMass[0]' 1,10,11 

2 StdMass =WinPrompt|CalData!'StdMass[1]' 1,8 

3 StdMass =WinPrompt|CalData!'StdMass[2]' 1,7,10,11 

4 StdMass =WinPrompt|CalData!'StdMass[3]' 1,7,8,13 

5 StdMass =WinPrompt|CalData!'StdMass[4]' 1,2,10,11,13 

6 StdMass =WinPrompt|CalData!'StdMass[5]' 1,2,8,13 

7 StdMass =WinPrompt|CalData!'StdMass[6]' 1,2,7,10,11,13 

8 StdMass =WinPrompt|CalData!'StdMass[7]' 1,2,7,8,13 

9 StdMass =WinPrompt|CalData!'StdMass[8]' 1-3,10,11,13 

10 StdMass =WinPrompt|CalData!'StdMass[9]' 1-3,8,13 

1 TestMass =WinPrompt|CalData!'TestMass[0]' 1,10,11 

2 TestMass =WinPrompt|CalData!'TestMass[1]' 1,8 

3 TestMass =WinPrompt|CalData!'TestMass[2]' 1,7,10,11 

4 TestMass =WinPrompt|CalData!'TestMass[3]' 1,7,8,13 

5 TestMass =WinPrompt|CalData!'TestMass[4]' 1,2,10,11,13 

6 TestMass =WinPrompt|CalData!'TestMass[5]' 1,2,8,13 

7 TestMass =WinPrompt|CalData!'TestMass[6]' 1,2,7,10,11,13 

8 TestMass =WinPrompt|CalData!'TestMass[7]' 1,2,7,8,13 

9 TestMass =WinPrompt|CalData!'TestMass[8]' 1-3,10,11,13 

10 TestMass =WinPrompt|CalData!'TestMass[9]' 1-3,8,13 

1 StdTotal =WinPrompt|CalData!'StdTotal[0]' 1.505926 

2 StdTotal =WinPrompt|CalData!'StdTotal[1]' 1.757368 

3 StdTotal =WinPrompt|CalData!'StdTotal[2]' 2.00894 

4 StdTotal =WinPrompt|CalData!'StdTotal[3]' 2.260646 

5 StdTotal =WinPrompt|CalData!'StdTotal[4]' 2.512484 

6 StdTotal =WinPrompt|CalData!'StdTotal[5]' 2.764457 

7 StdTotal =WinPrompt|CalData!'StdTotal[6]' 3.016567 

8 StdTotal =WinPrompt|CalData!'StdTotal[7]' 3.268812 

9 StdTotal =WinPrompt|CalData!'StdTotal[8]' 3.521195 

10 StdTotal =WinPrompt|CalData!'StdTotal[9]' 3.773717 

1 TestTotal =WinPrompt|CalData!'TestTotal[0]' 3.653589 

2 TestTotal =WinPrompt|CalData!'TestTotal[1]' 3.985724 
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3 TestTotal =WinPrompt|CalData!'TestTotal[2]' 4.758914 

4 TestTotal =WinPrompt|CalData!'TestTotal[3]' 5.115406 

5 TestTotal =WinPrompt|CalData!'TestTotal[4]' 5.888862 

6 TestTotal =WinPrompt|CalData!'TestTotal[5]' 6.221529 

7 TestTotal =WinPrompt|CalData!'TestTotal[6]' 6.995256 

8 TestTotal =WinPrompt|CalData!'TestTotal[7]' 7.328194 

9 TestTotal =WinPrompt|CalData!'TestTotal[8]' 8.102195 

10 TestTotal =WinPrompt|CalData!'TestTotal[9]' 8.435411 

1 Accepted =WinPrompt|CalData!'Accepted[0]' Yes 

2 Accepted =WinPrompt|CalData!'Accepted[1]' Yes 

3 Accepted =WinPrompt|CalData!'Accepted[2]' Yes 

4 Accepted =WinPrompt|CalData!'Accepted[3]' Yes 

5 Accepted =WinPrompt|CalData!'Accepted[4]' Yes 

6 Accepted =WinPrompt|CalData!'Accepted[5]' Yes 

7 Accepted =WinPrompt|CalData!'Accepted[6]' Yes 

8 Accepted =WinPrompt|CalData!'Accepted[7]' Yes 

9 Accepted =WinPrompt|CalData!'Accepted[8]' Yes 

10 Accepted =WinPrompt|CalData!'Accepted[9]' Yes 

1 Comment =WinPrompt|CalData!'Comment[0]' 0 

2 Comment =WinPrompt|CalData!'Comment[1]' 0 

3 Comment =WinPrompt|CalData!'Comment[2]' 0 

4 Comment =WinPrompt|CalData!'Comment[3]' 0 

5 Comment =WinPrompt|CalData!'Comment[4]' 0 

6 Comment =WinPrompt|CalData!'Comment[5]' 0 

7 Comment =WinPrompt|CalData!'Comment[6]' 0 

8 Comment =WinPrompt|CalData!'Comment[7]' 0 

9 Comment =WinPrompt|CalData!'Comment[8]' 0 

10 Comment =WinPrompt|CalData!'Comment[9]' 0 

1 Date =WinPrompt|CalData!'Date[0]' 12/03/1996 

2 Date =WinPrompt|CalData!'Date[1]' 12/03/1996 

3 Date =WinPrompt|CalData!'Date[2]' 12/03/1996 

4 Date =WinPrompt|CalData!'Date[3]' 12/03/1996 

5 Date =WinPrompt|CalData!'Date[4]' 12/03/1996 

6 Date =WinPrompt|CalData!'Date[5]' 12/03/1996 
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7 Date =WinPrompt|CalData!'Date[6]' 12/03/1996 

8 Date =WinPrompt|CalData!'Date[7]' 12/03/1996 

9 Date =WinPrompt|CalData!'Date[8]' 12/03/1996 

10 Date =WinPrompt|CalData!'Date[9]' 12/03/1996 

1 Time =WinPrompt|CalData!'Time[0]' 13:42:56 

2 Time =WinPrompt|CalData!'Time[1]' 13:43:31 

3 Time =WinPrompt|CalData!'Time[2]' 13:44:54 

4 Time =WinPrompt|CalData!'Time[3]' 13:45:11 

5 Time =WinPrompt|CalData!'Time[4]' 13:45:28 

6 Time =WinPrompt|CalData!'Time[5]' 13:45:46 

7 Time =WinPrompt|CalData!'Time[6]' 13:46:05 

8 Time =WinPrompt|CalData!'Time[7]' 13:46:49 

9 Time =WinPrompt|CalData!'Time[8]' 13:47:20 

10 Time =WinPrompt|CalData!'Time[9]' 13:47:35 

Calculate    

 TotalMass =WinPrompt|Calculate!TotalMass 5.038437 

 TareMass =WinPrompt|Calculate!TareMass 0.8400371 

 Trim =WinPrompt|Calculate!Trim 3.81 

 GasDensity =WinPrompt|Calculate!GasDensity 0 

 OilDensity =WinPrompt|Calculate!OilDensity 0 

 Reference =WinPrompt|Calculate!Reference 0 

 GasHeadPress =WinPrompt|Calculate!GasHeadPress 0 

 OilHeadPress =WinPrompt|Calculate!OilHeadPress 0 

 CorrPress =WinPrompt|Calculate!CorrPress 5 

 NominalMass =WinPrompt|Calculate!NominalMass 4.903326 

 PressCorr =WinPrompt|Calculate!PressCorr 1.00525 

 TempCorr =WinPrompt|Calculate!TempCorr 1.000105 

 GravityCorr =WinPrompt|Calculate!GravityCorr 9.78396E-06 

DwgA    

 Fpi =WinPrompt|DwgA!Fpi 0.01 

 Temp =WinPrompt|DwgA!Temp 30 

 Vacuum =WinPrompt|DwgA!Vacuum 100 

 SinkRate =WinPrompt|DwgA!SinkRate 0 

 Rotation =WinPrompt|DwgA!Rotation CW 
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DwgB    

 Fpi =WinPrompt|DwgB!Fpi 0.02 

 Temp =WinPrompt|DwgB!Temp 31 

 Vacuum =WinPrompt|DwgB!Vacuum 110 

 SinkRate =WinPrompt|DwgB!SinkRate 0 

 Rotation =WinPrompt|DwgB!Rotation CW 

Current    

 Temp =WinPrompt|Current!Temp 27 

 Humidity =WinPrompt|Current!Humidity 65 

 Barometer =WinPrompt|Current!Barometer 14.7 

 AirDensity =WinPrompt|Current!AirDensity 0.00004214 

 Gravity =WinPrompt|Current!Gravity 32.1044 

 StatusText =WinPrompt|Current!StatusText 11.1 Abs psi 14.53 Abs Ref 

 StatusColBack =WinPrompt|Current!StatusColBack Red 

 StatusColFore =WinPrompt|Current!StatusColFore Default 

System    

 Topics =WinPrompt|System!Topics o_System 

 SysItems =WinPrompt|System!SysItems o_System 

 Status =WinPrompt|System!Status Ready 

 Formats =WinPrompt|System!Formats TEXT 
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Appendix D 
Glossary 

Glossary 
Ao  
Effective area of the piston/cylinder at zero pressure and at the reference temperature. 

Absolute   
Pressure measurement referenced to absolute vacuum. See also gauge. 

Accepted   
Point for which calibration data has been recorded. 

Apparent Mass Reference Density   
Density used to computer Apparent Mass values. 

b1  
Linear coefficient of elastic distortion. 

b2  
Quadratic coefficient of elastic distortion. 

Buoyancy  
An object submerged in a fluid is buoyed up by the fluid. The air 
surrounding the deadweight gauge masses reduces the downward 
force acting on the piston. The equilibrium pressure acting on the 
bottom of the piston is also less. The buoyant effect of "normal" air 
acting on stainless steel deadweight gauge masses reduces the 
pressure by approximately 0.015% or 150 parts per million. See also 
Mass Apparent; Reference Density; and Density of Air. 

c  
Coefficient of thermal expansion. 

Calibration File   
Records all information for a single calibration. When a new calibration file is created, 
the user is prompted for a Procedure file to base it on. (Click Cancel on the Insert File 
dialog to create a Calibration file without loading a procedure.) 

Constant   
Allows entry of a fixed value for the variable. 

Cross Float   
The calibration of one deadweight gauge against another deadweight gauge. 
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D  
Reference dimension for the hanger mass. 

Data Acquisition   
Uses a hardware device to read the value directly. The hardware device must be attached 
and a driver installed. 

Density, Air   
Density of the air used to computer the buoyant effect of air on the masses. May be 
entered directly or computed from ambient temperature, humidity and pressure. 

Density, Gas    
Density of the gas medium used to compute head corrections. Gas density may be entered 
directly or may be computed from the gas used and the current pressure. 

Density, Oil   
Density of the oil medium used to compute head corrections. Oil density may be entered 
directly or may be selected from the list of available mediums. 

Density, True  
The actual density (mass per unit volume) of the mass or piston. See 

also Reference Density; Density of Air; and Mass Apparent. 

DUT  
Device under test, the device being calibrated. 

English Units: 
 Pressure psi 

 A0  in2 

 b1  in2/in2/psi 

 b2  in2/in2/psi2 

 c  in2/in2/oC 

 Mass  lbm 

 Head Height in 

 Elevation ft 

 Length  in 

 Sink Rate in/min 

 Vacuum microns 

 Temperature oC 

 Trim  g 

 Gravity  cm/sec2 

 Density  g/cm3 

 Humidity % RH 

Elevation   
Elevation above sea level for computing approximate Gravity. 

Float Position   
Distance of the piston from mid-float. Positive values are higher, negative values are 
lower than mid-float. 
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Formula   
Calculates the variable using other variables. See Gravity, and Air Density. 

Gauge   
Pressure measurement referenced to current atmospheric pressure. 

Gravity   
Force of gravity on the masses. May be entered directly or computed from Latitude and 
Elevation. 

Gravity Factor   
Mass correction factor for local gravity. 

Head Height   
Vertical distance between reference planes. A positive value indicates the Device Under 
Test is higher than the standard. 

Head Correction   
Pressure correction for head height. 

Humidity   
Current ambient relative humidity. Used to compute air density if not entered as a 
constant. 

+INF, -INF  
Infinity. The number is bigger than can be represented. Computing altitude at zero 
pressure will give this value. 

L1  
Distance from the top of the mass loading surface to the bottom of the piston. 

Latitude   
Distance from the equator in degrees and minutes of latitude. Used to compute local 
gravity if not entered as a constant. 

Mass, Apparent   
May be Apparent Mass versus Brass Standards or Apparent Mass versus Steel Standards. 
An expression of the effective mass of a given object with an assumed density, typically 
that of the standard used to measure the mass value. In a practical sense, Apparent Mass 
versus Brass Standards describes what an object appears to weigh when compared to a 
brass standard in the presence of a buoyant atmosphere. See also Buoyancy; Reference 
Density; True Mass; and Density of Air. 

Mass, Nominal   
Pressure converted to mass before corrections are applied. 

Mass, Tare   
Mass of the least number of components required to generate a pressure, in many cases 
the piston only. 

Mass, Total   
Mass used to generate a pressure. Included both platter masses and trim masses. 

Mass, Trim   
Small masses used to generate an exact pressure. 

Mass Set File   
Contains all information for a mass set. 

Medium   
The fluid or gas used to generate pressure. 



WinPrompt® 
Users Manual 

D-4 

+NAN, -NAN 
 Not A Number. The value cannot be computed (i.e., division by zero). 

Piston/Cylinder File   
Contains all information for a single piston/cylinder set. 

Pressure, Ambient   
Local atmospheric pressure. 

Pressure, Corrected   
Pressure after corrections have been applied. 

Pressure Factor   
Correction for the effect of pressure on the area of the piston. 

Pressure Units: 
 MPa  Megapascals 

 kPa  kilopascals 

 hPa  hectopascals 

 Pa  pascals 

 bar  bars 

 psi  pounds per square inch 

 kg/cm2  kilograms per square centimeter 

 mmHg 0oC millimeters of mercury at 0oC 

 cmHg 0oC centimeters of mercury at 0oC 

 inHg 0oC inches of mercury at 0oC 

 inHg 60oF inches of mercury at 60oF 

 cmH2O 4oC centimeters of water at 4oC 

 inH2O 4oC inches of water at 4oC 

 inH2O 20oC inches of water at 20oC 

 inH2O 25oC inches of water at 20oC 

 feet  feet of altitude 

 meters  meters of altitude 

 knots  airspeed knots 

 km/hr  airspeed kilometers per hour 

Procedure File   
Contains the setup for a calibration including piston, mass set, pressure sequence and 
environmental parameters. A procedure file is used to save the setup to be used for 
multiple calibrations.  

Reference Density  
Assumed density of the mass standard used to calibrate the mass. For mass values 
reported under the designation Apparent Mass versus Brass Standards, the Reference 
Density is typically 8.4 g/cm3. For the designation Apparent Mass versus Stainless Steel 
Standards, the Reference Density is typically 8.0 g/cm3. The appropriate value must be 
used for the Reference Density to achieve proper buoyancy corrections for gauge mode 
operation. For more information see Mass True, and Mass Apparent. 
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Reference Pressure   
The pressure all other pressures are measured against. See Absolute and Gauge. 

Requires   
Indicates what other mass (e.g. hanger mass) is required before the selected mass can be 
loaded onto the piston. 

Rotation   
Direction the masses are rotating when measurement is taken. 

Same As A   
Uses the value from the Deadweight Gauge A variable. 

SI Units: 
 Pressure MPa 

 Ao  m2 

 b1  m2/m2/MPa 

 b2  m2/m2/MPa2 

 c  m2/m2/oC 

 Mass  kg 

 Head Height cm 

 Elevation m 

 Length  m 

 Sink Rate cm/min 

 Vacuum mtorr 

 Temperature oC 

 Trim  g 

 Gravity  cm/sec2 

 Density  g/cm3 

 Humidity % RH 

Sink Rate   
Rate of descent of piston into cylinder. 

Sleeve Mass Offset   
Offset is used when a low mass sleeve is used, whether alone, or with additional masses. 

Standard Deadweight Gauge (DWG A)   
Known gauge that other devices are compared against. 

Temperature, Ambient   
Temperature of the room. 

Temperature, DWG   
Temperature of the gas or oil measured at the deadweight gauge. 

Temperature Factor   
Correction for the effect of temperature on the area of the piston. 

Temperature, Reference  
Temperature selected by manufacturer for reporting piston/cylinder area. 

Test Deadweight Gauge (DWG B)   
Unknown gauge in a cross-float calibration. 
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True Density   
Actual density of the mass or piston. 

True Mass   
Mass based on actual material density as if weighted in vacuum; a.k.a. Newtonian Mass. 

Uncertainty   
The amount of possible error in the value. 

Vacuum   
The difference between absolute vacuum and the vacuum actually used. 
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